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Docket No. 3125-4

Express Mail Label No. EJ917774582US

IN THE UNITED STATES PATENT AND TRADEMARK QFFICE

UTILITY APPLICATION AND APPLICATION FEE TRANSMITTAL (1.53(b))

ASSISTANT COMMISSIONER FOR PATENTS
Box Patent Application

Washington, D.C. 20231

Sir:

Transmitted herewith for filing is the patent application of

Named Inventor(s) and

Address(es): Keith R. McNally, Santa Clarita, CA; William H. Roof, San Diego, CA; Richard
Bergfeld, Chatsworth, CA

For: INFORMATION MANAGEMENT AND SYNCHRONOUS COMMUNICATIONS

SYSTEM WITH MENU GENERATION

Enclosed are:

[X] _26__page(s) of specification, __1 _page(s) of Abstract, 9 page(s) of claims

X] 7 sheets of drawing [ ]formal [x ]informal

[X]_6__page(s) of Declaration and Power of Attomey
[X] Unsigned
[ ] Newly Executed
[ 1 Copy from prior application

[ ] Deletion of inventors including Signed Statement under 37 C.F.R. § 1.63(d}(2)

[ ] Incorporation by Reference: The entire disclosure of the prior application, from which a copy of the
combined declaration and power of attorney is supplied herein, is considered as being part of the disclosure
of the accompanying application and is incorporated herein by reference.

[] Microfiche Computer Program (Appendix)

[] _ page(s) of Sequence Listing

computer readable disk containing Sequence Listing

)
[1] Statement under 37 C.F.R. § 1.821(f) that computer and paper copies of the Sequence Listing are
the same
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Docket No. 3125-4002

(] Claim for Prionity
(] Certified copy of Priority Document(s)
[] English translation documents
[} Information Disclosure Statement
[] Copy of ____ cited references
[] Copy of PTO-14489 filed in parent application serial No.
[1] Preliminary Amendment

[X] Return receipt postcard (MPEP 503)

[] Assignment Papers (assignment cover sheet and assignment documents)
(1 A check in the amount of $40.00 for recording the Assignment.
[1 Assignment papers filed in parent application Serial No.

[1 Certification of chain of title pursuant to 37 C.F.R. § 3.73(b).

[ ] Thisisa [ ] continuation [ ] divisional [ ] continuation-in-part (C-I-P) of prior application serial no.

[1] Cancel in this application original claims of the parent application before
calculating the filing fee. (At least one original independent claim must be retained for filing purposes.)

[] A preliminary Amendment is enclosed. (Claims added by this Amendment have been properly
numbered consecutively beginning with the number following the highest numbered original
e claim in the prior application.
= [ 1] The status of the parent application is as follows:
[ 1 A Petition For Extension of Time and a Fee therefor has been or is being filed in the parent

application to extend the term for action in the parent application until

[1 A copy of the Petition for Extension of Time in the co-pending parent application is attached.
[] No Petition For Extension of Time and Fee therefor are necessary in the co-pending parent
application.
{1 Please abandon the parent application at a time while the parent application is pending or at a time when

the petition for extension of time in that application is granted and while this application is pending has
been granted a filing date, so as to make this application co-pending.

1] Transfer the drawing(s) from the patent application to this application.
[ 1] Amend the specification by inserting before the first line the sentence:

Thisisa [ ]continuation [ ]divisional [ ] continuation-in-part of co-pending application Serial No.
filed
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I. CALCULATION OF APPLICATION FEE (For Other Than A Small Entity)

Basic Fee
Number Filed Number Extra Rate $760.00
Total
Claims 43 -20= 23 x$18.00 $414.00
“Independent
Claims 5 - 3= 2 x$78.00 $156.00
Multiple Dependent Claims o
[ 1yes Additional Fee = $260.00 $0
[X] no Add’l Fee = NONE

Total: § 1,330.00

(X1 A statement claiming small entity status is attached or has been filed in the above-identified parent
application and its benefit under 37 C.F.R. § 1.28(a) is hereby claimed. Reduced fees under 37 C.F.R.
§ 1.9(F) (50% of total) paid herewith $ 665.00.

X1 A check in the amount of $665.00) in payment of the application filing fees is attached.

1 Charge Fee(s) to Deposit Account No. 13-4500. OrderNo. . A DUPLICATE COPY OF
THIS SHEET IS ATTACHED.
[X] The Assistant Commussioner is hereby authorized to charge any additional fees which may be required for

filing this application, or credit any overpayment to Deposit Account No. 13-4500, Order No. 3125-4002.
A DUPLICATE COPY OF THIS SHEET IS ATTACHED.

Respectfully submitted,
MORGAN & FINNEGAN, L.L.P.

W. Osborne
Registration No. 36,231

Dated: September 21, 1999 By:

CORRESPONDENCE ADDRESS:

MORGAN & FINNEGAN, L.L.P.
345 Park Avenue

New York, New York 10154
(212) 758-4800

(212) 751-6849 Facsimile

FORM: UTL-TRAN.NY

Rev. 11/13/98
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Docket No. 3125-4002

IN THE UNITED STATES PATENT AND TRADEMARK OFFICE

spplicant(s) Keith R. McNally Group Art Unit : TBA
William H. Roof
Richard Bergfeld

Serial No. : TBA Examiner: TBA

Filed g September 21, 1999

For : INFORMATION MANAGEMENT AND SYNCHRONOQUS

COMMUNICATIONS SYSTEM WITH MENU GENERATION

EXPRESS MAIL CERTIFICATE

Assistant Commissioner for Patents
Washington, D.C. 20231

Express Mail Label No. __EJ917774582U3S

Date of Deposit September 21, 1999

[ hereby certify that the following attached paper(s) and/or fee

Application with 43 claims, 7 sheets of drawing figures; one (1) page abstract
Application Fee Transmuttal;

Filing Fee in the amount of $665.00;

Combined Declaration and Power of Attomey (unsigned);

Statement (Declaration) Claiming Small Entity Status; and

Retumn receipt postcard.

is being deposited with the United States Postal Service "Express Mail Post Office to Addressee" service under 37
C.F.R. §1.10 on the date indicated above and is addressed to the Assistant Commissioner for Patents, Washington,
D.C. 20231.

Francisco Garcia

(Typed or printed name of person
mailing 1(s) and/or fee)

AZFTIN o O
(ggnaturc of person ma}ﬁ'ng
paper(s) and/or fee)

CORRESPONDENCE ADDRESS:
MORGAN & FINNEGAN, L.L.P.
345 Park Avenue

New York, New York 10154

(212) 758-4800

(212) 751-6849 Facsimile
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EXPRESS MAIL CERTIFICATE Nh_. £J917774582U8
PATENT Attorney Docket No. 3125-4002

UNITED STATES PATENT APPLICATION

OF: KEITH R. McNALLY
WILLIAM H. ROOF
RICHARD BERGFELD

FOR: INFORMATION MANAGEMENT AND SYNCHRONOUS
COMMUNICATIONS SYSTEM WITH MENU
GENERATION

FIELD OF THE INVENTION

This invention relates to an information management and synchronous
communications system and method for generation of computerized menus for restaurants and
other applications with specialized display and synchronous communications requirements
related to, for example, the use of equipment or software with non-PC-standard graphical
formats, display sizes and/or applications for use in remote data entry, information management
and synchronous communication between host computer, digital input device or remote pager

via standard hardwired connection, the internet, a wireless link, smart phone or the like.

BACKGROQUND OF THE INVENTION

While computers have dramatically altered many aspects of modemn life, pen and
paper have prevailed in the hospitality industry, e.g., for restaurant ordering, reservations and
wait-list management, because of their simplicity, ease of training and operational speed. For
example, ordering prepared foods has historically been done verbally, either directly to a waiter
or over the telephone, whereupon the placed order is recorded on paper by the recipient or

instantly filled.

490392 1
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Although not previously adapted for wide-scale use in the hospitality industry,
various forms of digital wireless communication devices are in common use, e.g., digital
wireless messengers and pagers. Also in common use are portable laptop and handheld devices.
However, user-friendly information management and communication capability not requiring
extensive computer expertise has not heretofore been available for use in everyday life such as
for restaurant ordering, reservations and wait-list management. Hundreds of millions of dollars
have been spent on personal digital assistant (“PDA’") development seeking to produce a small,
light-weight and inexpensive device that could be adapted to such uses; yet none have yielded a
satisfactory solution.

One of the inherent shortcomings of PDA type devices is that, as they strive for
small size, low weight and low cost, they must compromise the size and clarity of the operator
display medium interface itself, which in most cases is one of a variety of LCD (liquid crystal
display) type devices. As the size of the display shrinks, the amount of information that may be
displayed at any one point or time is commensurately decreased, typically requiring multiple
screens and displays to display information to the operator. This reduces the overall utility of the
device. Additionally, the smaller display and keyboard results in a non-optimal operator
interface, which slows down operation and is thus unacceptable for the time criticality of
ordering, reservation and wait-list management and other similar applications. This necessitates
many design compromises which in the aggregate have resulted in limited acceptance of PDA
type devices in the restaurant and hospitality fields.

Many of the negatives prevalent in earlier devices have been eliminated, but, to
date, there is still no integrated solution to the ordering/waitlist/reservation problem discussed

above. With the advent of the Palm® and other handheld wireless devices, however, the efforts

490392 1
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1 to make such devices ubiquitous have begun to bear fruit at least in some areas, e.g., personal
2 calendars. However, substantial use of such devices in the restaurant and hospitality context has
3 not occurred to date. As discussed above, at least one of the reasons PDAs have not been
4 quickly assimilated into the restaurant and hospitality industries is that their small display sizes
5 are not readily amenable to display of menus as they are commonly printed on paper or displayed
6 on, e.g. large, color desktop computer screens. Another reason is that software for fully

7 realizing the potential for wireless handheld computing devices has not previously been

8 available. Such features would include fast and automatic synchronization between a central
= 9  database and multiple handheld devices, synchronization and communication between a World
iilﬂ Wide Web (“Web”) server and multiple handheld devices, a well-defined application program
E;ll interface (““‘API”) that enables third parties such as point of sale (“POS”) companies, affinity
j‘12 program companies and internet content providers to fully integrate with computerized
;-13 hospitality applications, real-time communication over the internet with direct connections or

n Il

regular modem dialup connections and support for batch processing that can be done periodically
55 throughout the day to keep multiple sites in synch with the central database. A single point of
;16 entry for all hospitality applications to communicate with one another wirelessly has also
17  previously been unavailable. Such a single point of entry would work to keep all wireless
18  handheld devices and linked Web sites in synch with the backoffice server (central database) so
19 that the different components are in equilibrium at any given time and an overall consistency is
20  achieved. For example, a reservation made online would be automatically communicated to the
21  backoffice server and then synchronized with all the wireless handheld devices wirelessly.
22 Similarly, changes made on any of the wircless handheld devices would be reflected

23 instantaneously on the backoffice server, Web pages and the other handheld devices.

-3-
¢/
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For the foregoing reasons, paper-based ordering, waitlist and reservations
management have persisted in the face of widespread computerization in practically all areas of
commerce. At most, computerization of these functions has been largely limited to fixed
computer solutions, i.e., desktop or mainframe, because of the problems heretofore faced in
configuring wireless handheld devices and maintaining database synchronization for such
applications. Specifically, the unavailability of any simple technique for creating restaurant
menus and the like for use in a limited display area wireless handheld device or that is
compatible with ordering over the intemet has prevented widespread adoption of
computerization in the hospitality industry. Without a viable solution for this problem,
organizations have not made the efforts or investments to establish automated interfaces to
handheld and Web site menus and ordering options.

A principal object of the present invention is to provide an improved information
management and synchronous communications system and method which facilitates user-
friendly and efficient generation of computerized menus for restaurants and other applications
that utilize equipment with non-PC-standard graphical formats, display sizes and/or applications.

A further object of the present invention is to provide an improved information
management and synchronous communications system and method which provides for entry,
management and communication of information from the operator as well as to and from another
computer, Web page menu, remote digital device using a standard hardwired connection, the
internet or a wireless link.

A further object of the present invention is to provide an improved information

management and synchronous communications system which is small, affordable and

490392 _1
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lightweight yet incorporates a user-friendly operator interface and displays menus in a readily
comprehensible format.

A further object of the present invention is to provide a synchronous information
management and communications system which enables automatic updating of both wireless and
internet menu systems when a new menu item is added, modified or deleted from any element of

the system.

SUMMARY OF THE INVENTION

The foregoing and other objects of the present invention are provided by a
synchronous information management and communications system and method optimized for
simplicity of operation which incorporates menu generation for creation of menus to be used
with wireless remote handheld computer and PDA devices, the internet or any application where
simple and efficient generation of menus is appropriate. The menu generation approach of the
present invention includes a desktop software application that enables the rapid creation and
building of a menu and provides a means to instantly download the menu configuration onto,
e.g., a handheld device or Web page and to seamlessly interface with standard point of sale
(“POS™) systems to enable automatic database updates and communication exchanges when a
change or input occurs in any of the other system elements. To solve the above and other related
problems, an information management and communications system is provided which results in
a dramatic reduction in the amount of time, and hence cost, to generate and maintain
computerized menus for, e.g., restaurants and other related applications that utilize non-PC-
standard graphical formats, display sizes or applications.

The menu generation approach of the present invention has many advantages over

previous approaches in solving the problem of converting paper-based menus or Windows® PC-

490392_1
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based menu screens to small PDA-sized displays and Web pages. In one embodiment, the
present invention is a software tool for building a menu, optimizing the process of how the menu
can be downloaded to either a handheld device or Web page, and making manual or automatic
modifications to the menu after initial creation.

The use of wireless handheld devices in the restaurant and hospitality industry is
becoming increasingly pervasive as restaurant owners and managers become more aware of the
benefits. With the proper wireless handheld system in place, restaurants can experience
increased table turns from improved server productivity and shorter order taking and check
paying times. Restaurants and POS companies seeking to provide a wireless handheld interface
to their desktop-based POS systems or a Web page equivalent face several challenges. These
challenges include building a menu using their existing database and transferring the menu onto
handheld devices or Web pages that will interface with servers wirelessly or to
restaurants/customers over the internet. The menu generation approach of the present invention
is the first coherent solution available to accomplish these objectives easily and allows one
development effort to produce both the handheld and Web page formats, link them with the
existing POS systems, and thus provides a way to turn a complicated, time-consuming task into a
simple process.

The information management and synchronous communications system of the
present invention features include fast synchronization between a central database and multiple
handheld devices, synchronization and communication between a Web server and multiple
handheld devices, a well-defined API that enables third parties such as POS companies, affinity
program companies and internet content providers to fully integrate with computerized

hospitality applications, real-time communication over the internet with direct connections or

490392 1
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regular modem dialup connections and support for batch processing that can be done periodically
throughout the day to keep multiple sites in synch with the central database.

The communication module also provides a single point of entry for all hospitality
applications, e.g., reservations, frequent customer ticketing, wait lists, etc. to communicate with
one another wirelessly and over the Web. This communication module is a layer that sits on top
of any communication protocol and acts as an interface between hospitality applications and the
communication protocol and can be easily updated to work with a new communication protocol
without modifying the core hospitality applications. A single point of entry works to keep all
wireless handheld devices and linked web sites in synch with the backoffice server applications
so that the different components are in equilibrium at any given time and an overall consistency
is achieved. For example, a reservation made online can be automatically communicated to the
backoffice server and then synchronized with all the wireless handheld devices wirelessly.
Similarly, changes made on any of the wireless handheld devices are reflected instantaneously on

the backoffice server Web pages and the other handheld devices.

D HE DRAWIN

The foregoing features and advantages of the present invention can be appreciated
more fully from the following description, with references to the accompanying drawings in
which:

IG. 1 is a schematic representation of a window displayed on a computer display
screen which shows a hierarchical tree menu, modifier window and sub-modifier window in
conformity with g4freferred embodiment of the present invention.

FIG. 2 is a schematic representation of a modifier dialog box in conformity with a

preferred embodiment of the present invention.

490392 1
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/FL673 is a schematic representation of a menu category dialog box in conformity
with a preferred embodiment of the present invention.

'_ )’6 4 is a schematic representation of a menu item dialog box in conformity with
a preferred embodiment of the present invention.

/ﬁ{j is a schematic representation of a display customization dialog box in

conformity with a prefeered embodiment of the present invention.

G. 6 is a schematic representation of a communications control window in

conformity with a prefe embodiment of the present invention.

" 7 is a schematic representation of a point of sale interface on a wireless
handheld device for use in displaying page menus created in conformity with a preferred

embodiment of the present invention.

IL H v

Most personal computers today run under an operating system that provides a
graphical user interface (“GUI”) for accessing user applications. A GUI is used in the preferred
embodiment of the present invention. Through an interface of windows, pull-down menus, and
toolbars, GUI operating systems have simplified PCs and have rendered computer technology
more user friendly by eliminating the need to memorize keyboard entry sequences. In addition,
GUIs allow users to manipulate their data as they would physical entities. For example, a
window can represent a file and the contents of the window can represent the records of the file.
The window can be opened, closed, or set aside on a desktop as if it were an actual object. The
records of the file can be created, deleted, modified and arranged in a drag-and-drop fashion as if
they also were physical objects. The most common GUI operating systems that provide this

®

“object-ariented” environment for personal computers are Microsoft Windows™ systems,

490392_1
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including Windows CE® for handheld wireless devices and the like. Generally, a particular
application program presents information to a user through a window of a GUI by drawing
images, graphics or text within the window region. The user, in turn, communicates with the
application by “pointing” at graphical objects in the window with a pointer that is controlled by a
hand-operated pointing device, such as a mouse, or by pressing keys on a keyboard.

The use of menus is conventional in GUIs for software applications. Menus are
typically utilized to provide end users of applications with available choices or processing
options while using the applications. For example, in a typical desktop or interactive application,
selection of a “file” from a menu bar may cause display of a context menu which provides “file”
options. File options can have additional subordinate or child options associated with them. If a
file option having subordinate options is selected, the child options are displayed in context in a
child menu or submenu proximate to the selected parent option. One or more of the child
options provided in the child menu may have further subordinate options. Thus, such a menu
system comprises cascading sets of menus which are displayable in context to show the
parent/child relationships between options of the context menu. A menu system of this type is
incorporated into the preferred embodiment of the invention.

The preferred embodiment of the present invention uses typical hardware
elements in the form of a computer workstation, operating system and application software
elements which configure the hardware elements for operation in accordance with the present
invention. A typical workstation platform includes hardware such as a central processing unit
(“CPU”), eg., a Pentium® microprocessor, RAM, ROM, hard drive storage in which are stored
various system and application programs and data used within the workstation, modem, display

screen, keyboard, mouse and optional removable storage devices such as floppy drive or a CD
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ROM drive. The workstation hardware is configured by software including an operating system,
c.g. Windows® 95, 98, NT or CE, networking software (including internet browsing software)
and application software components. The preferred embodiment also encompasses a typical file
server platform including hardware such as a CPU, e.g., Pentium® microprocessor, RAM, ROM,
hard drive, modem, and optional removable storage devices, e.g., floppy or CD ROM drive. The
server hardware is configured by software including an operating system, e.g., Windows® 95, 98,
NT or CE, networking software (including Web server software) and database software.

A computer workstation for use in the preferred embodiment also includes a GUI.
As is conventional, the GUI is configured to present a graphical display on the display screen
arranged to resemble a single desktop. Execution of an application program involves one or
more user interface objects represented by windows and icons. Typically, there may be several
windows and icons simultaneously present on the desktop and displaying information that is
generated by different applications.

The window environment is generally part of the operating system software that
includes a collection of utility programs for controlling the operation of the computer system.
The computer system, in turn, interacts with application programs to provide higher level
functionality, including a direct interface with the user. Specifically, the application programs
make use of operating system functions by issuing task commands to the operating system which
then performs the requested task. For example, an application program may request that the
operating system display certain information on a window for presentation to the user.

An aspect of the preferred embodiment of the information management and
communications system of the invention is shown in FIG. 1. FIG. 1 shows an example of the
GUI provided by the operating system of the preferred embodiment of the present invention.

-10 -
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With reference to FIG. 1, the preferred embodiment includes an intuitive GUI 1 from which to
build a menu on a desktop or other computer. A hierarchical tree structure 2 is used to show the
different relationships between the menu categories 3 (e.g., soups, salads, appetizers, entrees,
deserts, ctc.), menu items 4 (e.g., green salad, chicken caesar salad, etc.), menu modifiers 5 (e.g.,
dressing, meat temperature, condiments, etc.) and menu sub-modifiers 6 (e.g., Italian, French,
ranch, bleu cheese, etc.).

The procedure followed in configuring a menu on the desktop PC and then
downloading the menu configuration onto the POS interface on the handheld device in
conformance with the preferred embodiment is as follows.

The menu configuration application is launched by clicking on the appropriate
icon on the desktop display screen. FIG. 1 will then be displayed. There are three windows on
the screen shown in FIG. 1. The left window is the menu tree 7, also called the tree view. The
top right window is the Modifiers window 8 and the bottom right window is the Sub-Modifiers
window 9. The Sub-Modifiers window lists the sub-modifiers that correspond to the modifier
that is selected. The views on the right are referred to as list views. There are several ways of
invoking a command, including using the menu options; using the context menu (right mouse
click); using the keyboard or using the toolbar icons. For example, if it is desired to add a
category to the menu, the following four options are available: (1) clicking on Edit, Add
Category; (2) right mouse clicking on Menu, then clicking on Add Category; (3) highlighting
Menu, then typing Ctrl + T or (4) clicking on the Add Category icon on the toolbar. To add an
item to a category, the following options are available: (1) highlighting the category to which it

is desired to add an item and then clicking on Edit > Add Item; (2) right mouse clicking on the
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desired category and then clicking on Add Item; (3) highlighting the desired category, then

typing Ctrl + N or (4) clicking on the Add icon on the toolbar.

When building a menu, it should be kept in mind that the menu items are stored

using a tree metaphor similar to how files are stored on a PC with folders and subfolders. The

menu structure is similar to the Windows® File Explorer in the way the items are organized

hierarchically. Below is an example of how an item may be configured:

A

Menu

>> Entrees

>>

Red Meat
>> NY Strip
>> Vegetables
>> Tomato
>> Lettuce
Meat Temperature
>> Medium Rare

In the above example, Menu is the root. Entrees is a menu category. Red Meat is an Entree

category. NY Strip is a modifier. Vegetable is a modifier. Meat Temperature is a modifier.

Medium Rare is a sub-modifier of Meat Temperature.

The steps taken in building a menu are as follows:

1.

ne O S o

Add Modifiers;

Add Sub-Modifiers and link them to the Modifiers;

Create Menu categories;

Add menu items to the categories;

Assign Modifiers to the menu items;

Preview the menu on the POS emulator on the desktop PC;

Download the menu database to the handheld device.

To add modifiers, a user clicks on the inside of the Modifiers window, then (1)

clicks on Edit>Add Modifier; (2) Presses Ctrl + N; (3) right mouse clicks in the Modifiers

window, then clicks on Add Modifiers or (4) clicks on the Add icon from the toolbar. If a menu

490392 1
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is being built from scratch, the procedure is to enter the Long Name, Short Name, Code and
Price in the Modifier dialog box 10 shown in FIG. 2. The Long Name is the full descriptive
name of the item. The Short Name is the abbreviated name that will be displayed on the
handheld device. The Code is the numeric or alphanumeric code for the item. If there is an
existing database, the existing database can be browsed and menu items retrieved from the
database. Clicking on the Browse button will bring up the existing database of menu items. The
item to be added is then selected and “OK” is clicked. The fields will then be filled with the
information from the database. Clicking on OK again will add the item as a modifier. To delete
a modifier, the modifier is selected and the Delete key pressed on the keyboard. To edit a
modifier, either the modifier is double clicked or the Enter key is pressed.

Sub-modifiers represent the last level of modifiers that can be assigned to a menu
tree. To add sub-modifiers, the modifier to which sub-modifiers are to be assigned is selected.
Then, the focus is set on the sub-modifier window by clicking inside the Sub-Modifier window
as follows: (1) clicking on Edit>Add Sub-Modifier; (2) pressing Ctrl + N; (3) right mouse
clicking in the Sub-Modifiers window, then clicking on Add Sub-Modifiers or (4) clicking on the
Add icon from the toolbar. If a menu is being built from scratch, the procedure is to enter the
Long Name, Short Name, Code and Price in a Sub-Modifier dialog box similar to the Modifier
dialog box shown in FIG. 2. As with modifiers, the Long Name is the full descriptive name of
the item. The Short Name is the abbreviated name that will be displayed on the handheld device.
The Code is the numeric or alphanumeric code for the item. As before, if there is an existing
database, the existing database can be browsed and menu items retrieved from the database.
Clicking on the Browse button will bring up the existing database of menu items. The item to be

added is then selected and OK clicked. The fields will then be filled with the information from
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the database. Clicking on OK again will add the item as a sub-modifier. To delete a sub-
modifier, the sub-modifier is selected and the Delete key depressed on the keyboard. To edit a
sub-modifier, either the sub-modifier is double clicked or the Enter key is pressed.

Menu categories are created from the root. Some examples of categories are
Appetizers, Soups, Salads, Entrees, Desserts, etc. The first step is to click on Menu in the menu
tree window. Categories are added by (1) clicking on the Add Category icon from the toolbar;
(2) clicking on Edit > Add Category or (3) pressing Ctrl + T. As shown in FIG. 3, Menu
Category dialog box 11 then appears in which to enter the Long and Short names for the menu
category.

To add menu items to categories, the menu category which is being built is
clicked. For example, if items are being added to Appetizers, the Appetizers branch is clicked
on. Then the Edit > Add Item is clicked on or Ctrl + N pressed. As before, if a menu is being
built from scratch, the procedure is to enter the Long Name, Short Name, Code, Prep Time,
Recipe and Price into the Menu Item dialog box 12 shown in FIG. 4. The Long Name is the full
descriptive name of the item. The Short Name is the abbreviated name that will be displayed on
the handheld device. The Code is the numeric or alphanumeric code for the item. Prep Time is
the time it takes to prepare the meal and Recipe would include preparation methods and
ingredients that are used in the preparation of the item. If there is an existing database, the
existing database can be browsed and menu items retrieved from the database. Clicking on the
Browse button will bring up the existing database of menu items. The item to be added is then
selected and OK is clicked. The fields will then be filled with the information from the database.

Clicking on OK again will add the item to the category.

- 14 -
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Once the menu items have been entered, it may be desired to assign some
modifiers to the menu items. For example, it may be desired to assign meat temperature to a
steak order. To accomplish this, first the modifier to be assigned is selected, then the menu item
on the tree view that is to be assigned the modifier is clicked on and then Edit > Assign Modifier
is clicked on. Or, the modifier can simply be dragged and dropped onto the menu item to link
them. A dialog box is then displayed asking if this modifier is a required modifier. If it is a
required modifier, the display icon will be red but if it is a non-required modifier the display icon
will be green. As many modifiers as are applicable can be assigned. If any changes are made to
the modifiers, those changes will be automatically reflected throughout the menu tree.

Once the modifiers have been entered, it may be desired to assign sub-modifiers
to the modifiers items. For example, it may be desired to add Honey Mustard as a sub-modifier
to Dressing. To accomplish this, first the modifier to be assigned a sub-modifier is selected, then
the sub-modifier window is clicked on, then Edit > Add Sub Modifier is clicked on, Ctrl+N
entered or the Add icon from the toolbar is clicked on. Or, the sub-modifier can simply be
dragged and dropped onto the modifier to link them.

When the menu has been completely configured, it can be previewed on a POS
emulator on the desktop to verify that the menu is correctly configured before downloading it to
the handheld device. To preview, File > Preview Database 1s clicked on or the Preview Database
icon from the toolbar is clicked on. The handheld POS emulator on the desktop can then be run.
If the configuration is deemed acceptable, the handheld device is connected to the desktop PC to
ensure that a connection has been established; the POS application on the handheld device is
exited and File > Download Database is clicked on or the Download Database icon from the

toolbar is clicked on. If there is an existing menu database on the handheld device, the system

- 15 -
490392 1

Apple, Exhibit 1010, Page 25



p— =] O

(4]

i i e R 0 U
(=)} w L= W

._.
-~

19

20

21

22

23

will ask if the existing database should be replaced. Yes is clicked if existing database
replacement is desired.

A database function enables the creation of, e.g., a breakfast menu, lunch menu
and dinner menu and downloading them to a handheld device. Functions available are (1)
creating a new database; (2) opening an existing database; (3) saving a database under a different
name. To access these functions, File is clicked on the menu bar.

The preferred embodiment encompasses customized layout, views and fonts. To
set the focus on the view it is desired to change, click inside the desired window. The main
customizing dialog box is accessed by clicking on View > Customize View. A dialog box 13, as
shown in FIG. 5, will be displayed including tabs that allow the following options: selection of
Columns to display in the list view by choosing and arranging the fields to display in the
Modifiers and Sub-Modifiers windows; formatting Columns by specifying the column widths
and justification; selecting Filter allows restricting the list to display only the items that meet
certain criteria. For example, display of modifiers with codes between 500 and 550. Selecting
Sort allows sorting the modifiers or sub-modifiers according to any of the available fields such as
Name, Code or Price. Selecting Style facilitates choice of font type, style, size, etc. To change
the font in a particular window, click on View > Fonis or right mouse click in the desired
window and then click on Fonts. To change the size of the windows, drag the borders of the
windows to expand or contract the size of the windows. To change the column widths, simply
drag the edge of the column headers to increase or decrease the column widths.

A communications control program monitors and routes all communications to
the appropriate devices. It continuously monitors the wireless network access point and all other

devices connected to the network such as pagers, remote devices, intemet Web links and POS
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software. Any message received is decoded by the software, and then routed to the appropriate
device. No user action is needed during operation of the software once the application has been
launched. To launch the communications control module, a Wireless Traffic icon is clicked on
the desktop PC. When the program loads, the screen shown in FIG. 6 appears. Messages
received are logged in the window 14 shown in FIG. 6 with a time stamp. The messages are also
logged to a file on the hard drive. This provides a mechanism to monitor all traffic across the
network (possibly useful for troubleshooting, or maintenance, but not necessary for normal
operation). The program may be minimized so the screen is not displayed on the desktop, but it
must be running for proper communications to exist between all devices on the network.

As stated, the preferred embodiment of the present invention includes the use of
and compatibility with GUI technology. A drag-and-drop approach is used for organizing the
tree structure 2 in the generated menu. Drag-and-drop is also used for assigning modifiers
(modifiers can be dragged from the modifiers window 5 and dropped onto the menu item 4 for
assignment). In-cell editing results in fast editing of items in building the menus. Customizable
fonts enable users to change font types, style and size. Customizable layouts enable users to
resize windows, change icons and display preferences. The inventive approach provides for
fully persistent storage between sessions, even if a session is improperly or abruptly terminated.
Font and the tree state (i.e., which nodes are expanded/collapsed) are stored between sessions.
Layout for modifiers and sub-modifiers list views (filter, columns, formatting, font, etc.) are
stored between sessions. The last database usecd is likewise stored between sessions.  Splitter
views allow the user to see different views at the same time. Each view is displayed on its own
section of the screen. Views can be resized via the keyboard or a mouse by simply dragging the

splitter in the middle.
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An automated function is provided to import existing POS databases into the
inventive menu generation system and, as discussed above with respect to the detailed example
of how to use the preferred embodiment, an automated download procedure is provided to
transfer the desktop database onto a handheld device and/or Web page. Also as discussed, the
preferred embodiment facilitates preview of the handheld device or Web page version of the
POS menu on the desktop before downloading and configuration. Customizable desktop menu
generation is contemplated, as discussed above, in the form of customizable fonts, columns,
layouts, etc. The inventive approach also includes templates for common modifiers that can be
assigned to similar menu items. The preferred embodiment also supports multiple databases,
thus providing for the creation and storing of different menu databases on handheld devices such
as breakfast, lunch or dinner menus. The user can then select the appropriate database to reflect
the time of day.

FIG. 7 is a schematic representation of a point of sale interface 15 for use in
displaying a page-type menu 16 created using the inventive menu generation approach. As can
be seen from FIG. 7, the page menu is displayed in a catalogue-like point-and-click format
whereas the master menu, FIG. 1, is displayed as a hierarchical tree structure. Thus, a person
with little expertise can “page through” to complete a transaction with the POS interface and
avoid having to review the entire menu of FIG. 1 to place an order. A PDA or Web page format
could appear like FIG. 7 or the display could be configured for particular requirements since
fully customizable menu generation and display are contemplated.

The POS interface on the handheld device supports pricing in the database or
querying prices from the POS server. The POS device also can be customized with respect to

“look and feel” for the particular version. As can be seen in FIG. 7, the POS interface provides
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for billing, status and payment with respect to orders. A myriad of options can be provided
depending on the application.

Advanced database functions are provided in the preferred embodiment of the
invention, including an automated download process onto handheld devices and/or Web sites. In
the preferred embodiment, the menu generation system of the present invention uses an API
called ActiveX Data Objects (“ADO”) for database access. ADO is useful in a variety of
settings. It is built on top of OLE DB and can be used to talk to databases and, in the future, any
data source with any OLE DB driver. Advanced querying is supported. The database can be
queried on virtually all fields. Queries can be built using SQL syntax for experienced users or
can be created using a query builder which guides users through the creating process. Advanced
error handling is supported. Errors occurring at run time can be trapped. A descriptive message
is displayed to alert the user and provide error information. However, the application does not
terminate when the errors happen. The source code is easy to maintain and modify, thus
allowing for on time delivery of customized versions of the software. The advanced database
functions produce well-designed databases that accommodate growth and scalability

The inventive menu generation approach provides a solution for the pervasive
connectivity and computerization needs of the restaurant and related markets. The inventive
solution includes automatic database management and synchronization, PDA and handheld
wireless operating system integration and optimization, wireless communications and internet
connectivity, user interface design, and graphics design.

In the preferred embodiment, the menu generation approach of the present

invention uses Windows CE® as the operating system for the handheld devices. Windows CE®

provides the benefits of a familiar Windows 95/98/NT® look and feel, built-in synchronization
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between handheld devices, internet and desktop infrastructure, compatibility with Microsoft
Exchange®, Microsoft Office 9° and TCP/IP quick access to information with instant-on feature.
Windows CE® provides a basic set of database and communication tools for
developer use. However, interfacing with these tools to provide application specific results can
be a complex task. In addition to the menu generation described above, a set of software
libraries described herein in conformance with the present invention not only enhances the basic
Windows CE® functionality by adding new features but also maximizes the full potential of
wireless handheld computing devices. Such features include fast synchronization between a
central database and multiple handheld devices, synchronization and communication between a
Web server and multiple handheld devices, a well-defined API that enables third parties such as
POS companies, affinity program companies and internet content providers to fully integrate
with computerized hospitality applications, real-time communication over the internet with direct
connections or regular modem dialup connections and support for batch processing that can be
done periodically throughout the day to keep multiple sites in synch with the central database.
The synchronous communications control module discussed above provides a
single point of entry for all hospitality applications to communicate with one another wirelessly
or over the Web. This communications module is a layer that sits on top of any communication
protocol and acts as an interface between hospitality applications and thc communication
protocol. This layer can be easily updated to work with a new communication protocol without
having to modify the core hospitality applications. The single point of entry works to keep all
wireless handheld devices and linked Web sites in synch with the backoffice server (central
database) so that the different components are in equilibrium at any given time and an overall

consistency is achieved. For example, a reservation made online is automatically communicated
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to the backoffice server which then synchronizes with all the wireless handheld devices
wirelessly. Similarly, changes made on any of the wireless handheld devices will be reflected
instantaneously on the backoffice server and the other handheld devices.

The software applications for performing the functions falling within the
described invention can be written in any commonly used computer language. The discrete
programming steps are commonly known and thus programming details are not necessary to a
full description of the invention.

A simple point-to-point wireless capability is contemplated which permits simple
digital messages to be sent from the wireless handheld devices to a receiver in a beeper and/or
valet parking base-station. The POS interface of FIG. 7 is representative of the display on a
typical wireless device used in conformity with the invention. A simple protocol is used to
acknowledge receipt of the message and thus simultaneous communication is not necessary,
which reduces the cost of the wireless link. The range of the wireless link is determined by the
characteristics of the radio transceiver. Adding a wireless link allows paging of beeper equipped
customers directly from the operator interface on the wireless handheld devices and
communication to and from various input/output transmitters and receivers to update the status
of the order, reservation or other information and thus further reduce the workload on the
operator and enable operations to proceed much faster. This link could also be hardwired or
otherwise implemented using any two-way messaging transport.

A further aspect of the invention is the use of the menus generated in accordance
with the described technique to place orders from wireless remote handheld devices or from
remote locations through the intemet. The World Wide Web 1s a distributed hypermedia

computer system that uses the internet to facilitate global hypermedia communication using
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specified protocols. One such protocol is the Hypertext Transfer Protocol (“HTTP”), which
facilitates communication of hypertext. Hypertext is the combination of information and links to
other information. In the context of the Web, hypertext is defined by the Hypertext Mark-up
Language (“HTML”). The links or hyperlinks in a HTML document reference the locations of
resources on the Web, such as other HTML documents. Another language used in creating
documents for use on the Worldwide Web, to display on computer screens, or to create speech
style sheets for use in, e.g., telephones, is the Extensible Mark-Up Language (“XML”). XML is
a “metalanguage”, i.e., a language for describing languages which was developed to eliminate
the restrictions of HTML.

The Web is a client-server system. The HTML documents are stored on Web
server computers, typically in a hierarchical fashion with the root document being referred to as
the home page. The client specifies a HTML document or other source on the server by
transmitting a Uniform Resource Locator (“URL”) which specifies the protocol to use, e.g.,
HTTP, the path to the server directory in which the resource is located, and filename of the
resource. Users retrieve the documents via client computers. The software running on the user’s
client computer that enables the user to view HTML documents on the computer’s video monitor
and enter selections using the computer’s keyboard and mouse is known as a browser. The
browser typically includes a window in which the user may type a URL. A user may cause a
URL to be transmitted by typing it in the designated window on the browser or by maneuvering
the cursor to a position on the displayed document that corresponds to a hyperlink to a resource
and actuating the mouse button. The latter method is commonly referred to simply as “clicking
on the hot-spot” or “clicking on the hyperlink”. The hyperlink methodology is contemplated for

use in accordance with the preferred embodiment to transmit orders via the internet.
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Web server application software exists that enables a user to shop for and order
merchandise. Such systems are sometimes referred to as electronic merchandising systems or
virtual storefronts. Systems that enable a user to choose among several retailers’ goods are
sometimes referred to as electronic malls. An electronic retailer’s or electronic mall operator’s
Web server provides HTML forms that include images and descriptions of merchandise. The
user may conventionally search for an item by entering a key word search query in a box on a
form. When a user selects an item, the server may provide a linked form that describes that item
in further detail. The user may also conventionally enter ordering information into boxes on the
form, such as the type and quantity of the item desired. The information entered by the user is
transmitted to the server. The user may select multiple items in this manner and then enter a
credit card number to pay for the purchases. The retailer processes the transaction and ships the
order to the customer. As can be appreciated, ordering merchandise can also be done from
menus. The generation of menus of items or merchandise for sale over the internet is readily
accomplished by the menu generation approach of the present invention.

Searching for items that the user is interested in purchasing is insufficient in prior
merchandising systems. Database management programs use index searching to facilitate rapid
searching of large amounts of data. The creator of the database may instruct the program to use
specified fields in the database as indexed or key fields. The program locates all terms in the
database that appear in the indexed fields and stores them in an index table. Each entry in the
index table includes a term and corresponding pointer to the location in the database where the
term is found. If a user initiates a search for a term that is present in the index table, the program
can locate the instances of that term in the database with exceptional speed. Users who are

familiar with the particular database they are searching will generally know which fields are
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indexed and will know the format of the data in those fields. For example, a user of a database
containing the inventory of a bookstore may know that users can search for the names of authors
of books and that a user who wishes to do so should enter the author’s last name first. A user
having such knowledge will therefore be able to search efficiently. Users of electronic
merchandising systems, however, are generally end-consumers who have no knowledge of a
merchant’s database. If, as is very likely, such a user initiates a search for a term that is not
present in the index table, the program must sequentially search through all records in the
database. Sequential records are typically linked by pointers. Using pointers in this manner is
very demanding on server resources, resulting not only in an exceptionally slow search, but also
creating a bottleneck for other processes that the server may be executing. The menu generation
approach of the present invention can be used to create customized menus from a database that
includes every item of merchandise the vendor has for sale. In this manner, customers can scan
the generated menu much more readily than they could view the entire database and the
necessity of having familiarity with the database is eliminated as well, reducing the need for
resource intensive pointers.

While the preferred embodiment of the invention is for the generation of
restaurant menus and the like, the broad scope of the invention is far greater. For example,
menus generated in accordance with the invention can be used in the desktop computing
environment in association with the operating system or application programs. One such use is
to facilitate the creation of user personalized file structures for general desktop use. Another use
is to facilitate the location of customized menus from master menus for use in association with
application software to make the execution of the application software more efficient by, e.g.,

eliminating the necessity of querying or checking every tree branch in the master menu file
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structure in response to user input or other criteria and to create handheld/PDA compatible
versions of the software.

While the preferred embodiment of the invention includes the selection of items
from a master menu wherein the master menu is displayed using a graphical user interface, it is
to be appreciated that any means for displaying the master menu to the user and generating
another menu in response to and comprised of the selections made is encompassed by the
contemplated invention. The invention encompasses the selection of nontextual symbols,
characters, icons and the like, in addition to text, from a hierarchical tree menu or the like for
generation of another menu comprised of such items.

It is also within the scope of the invention to generate menus automatically in
response to predetermined criteria. For example, in the restaurant menu generation embodiment,
a modified menu can be generated to comply with a particular specification or group of criteria
such as, e.g., “dinner”, “low cholesterol”, “low fat”, “fish”, “chicken”, or *“vegetarian”. In this
embodiment, only items from the master menu that satisfy specified parameters will be included
in the generated menu. The selection process could involve seclection of master menu items
based on tags or identifiers associated with the items or by checking every master menu item
against a dictionary of items acceptable for inclusion in the modified menu. It should also be
appreciated that the invention encompasses any combination of automatic and manual user
selection of the items comprising the generated menu. For example, a user might specify criteria
which would further control automatic selection or the user could manually select some items
with automatic selection of others. The menu generation aspect of the invention is equally
applicable to table-based, drive-thru, internet, telephone, wireless or other modes of customer

order entry, as is the synchronous communications aspect of the invention.
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The inventive concept encompasses the generation of a menu in any context
known to those skilled in the art where an objective is to facilitate display of the menu so as to
enable selection of items from that menu. The restaurant menu generation embodiment is but
onc example of a use for the inventive concept. Likewise, displaying menus generated in
accordance with the invention on PDAs and Web pages to facilitate remote ordering are but a
few examples of ways in which such a menu might be used in practice. Any display and
transmission means known to those skilled in the art is equally usable with respect to menus
generated in accordance with the claimed invention.

In the more general situation, menus can be generated in accordance with the
present invention in a variety of situations. For example, the usable file structure for a particular
data processing application can be dictated by the user or an application program prior to or
during the execution of the application program. Efficiencies with respect to computational
speed and equipment, e.g., storage and processor, usage can thus be achieved along with the
facilitation of display of the generated menu.

While the best mode for carrying out the preferred embodiment of the invention
has been illustrated and described in detail, those familiar with the art to which the invention
relates will recognize various alternative designs and embodiments which fall within the spirit of
practicing the invention. The appended claims are intended to cover all those changes and

modifications falling within the true spirit and scope of the present invention.
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1 That which is claimed is:

L. An information management and synchfonous communications system for

generating menus comprising:

4 a. acentral processing unit,
5 b. a data storage device cgnnected to said central
6 processing unit,

7 c. an operating system ifacluding a graphical wuser

8 interface,

9 d. a first menu stored on said data storage device,
%0 e. application software for generating a second menu from
"i;"] 1! said first menu,
= f
EZ wherein the application software facilitates/ the generation of the second menu by allowing
=
QS;' selection of items from the first menu, addition of items to the second menu and assignment of
. 14 parameters to items in the second meny using the graphical user interface of said operating
E .
45  system.
at
= . . .. .
=6 An information management and synchronous communications system in
]
8
’ﬁl?\ accordance with claim 1, wherein the second menu 1s a restaurant menu.

18 3. An informatign management and synchronous communications system in

19 accordance with claim 1, wherein the sebQnd menu is capable of being displayed on the display
20  screen of a wireless computing device.
21 4. An information management and synchronous communications system in

22| accordance with claim 3, wherein selections from the“econd menu are capable of being

23 transmitted to a receiving computer by wireless link.

-27 -
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5. An information management and synchronous communications system in

accordance with clayjm 1, wherein the second menu is capable of being displayed on display

accordance with claim 3, wherein\selections from the second menu are capable of being
transmitted to a receiving computer via the internet.

8. An information mandgement and synchronous communications system in
accordance with claim 1, wherein the secor] menu is created in conformity with hypertext
markup language or extensible markup language. g

9. An information management ¥nd synchronous communications system in
accordance with claim 1, wherein the second menu ovekwrites the first menu.

10.  The information management and sxnchronous communications system of
claim 1, wherein the first menu and the second menu are bo¥ capable of being displayed in the
same window on the display screen.

11 The information management and synchrorpus communications system of
claim 1, wherein the items comprising the second menu are a subsel of the items comprising the
first menu.

d synchronous communications system for

{a,/ 12. An information management
generating menus comprising:
a. a miCroprocessor
b. a display devic

C. a data and instruction input device,

-28 -
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d. a data storage device for storing information and
instructions entered through said data and
instruction input means of information generated by
said microprocessor,

e. an operating system,

on said data storage device for
d menu, and

f. a master menu stor
generating a modifi

g. application software,
wherein said microprocessor, operating systeng and application software are operative to display
the master menu on the dispiay device in response to instructions programmed into said
microprocessor, operating system, applicatipn software and information and instructions entered

through said data input device, and erein said microprocessor, operating system and
application software are operative to greate the modified menu from said master menu in

response to information and instructiond entered through said data and instruction input device.

13. e information management and synchronous communications system of

claim 12, further comprising means for transferring the modified menu to a digital computing
device.

14.  The informatidg management and synchronous communications system of
claim 13, wherein the digital computing device is a wireless handheld device.

15.  The information managgment and synchronous communications system of

claim 12, further comprising means for download¥g the modified menu to the internet or a Web

page.
16.  The information management and Synchronous communications system of

claim 15, further comprising means for converting the mpdified menu to hypertext markup

language or extensible markup language.

229 -
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" wherein said microprocessor, operating

o

:
|
|

| user interface of said operating system.

17. The information management and synchronous communications system of

claim 15, wherein the Kems comprising the modified menu are a subset of the items comprising

the master menu.

18. ation management and synchronous communications system in

accordance with claim 12, wherein'said operating system includes a graphical user interface and

stem and application software are operative to generate

the modified menu by facilitating selection\Qf items from said master menu using the graphical

19. An information management agd synchronous communications system in

accordance with claim 12, wherein said master menu is d{ganized in a hierarchical tree structure

having branches comprising menu items and wherein the Wodified menu is at least partially

generated by selecting items from the branches of the tree struct
/ }9" An information management and synchronous communications system for
generating and transmitting menus comprising:

a. a central processing unit,

b. a data storage device connected to said central
processing unit,

¢. an operating system including a graphical user
interface,

d. a first menu consisting of menu categories, said menu
categories consisting of menu items, said first menu
stored on said data storage device and displayable in a
window of said graphical user interface in a hierarchical
tree format,

e. a modifier menu stored on said data storage device and
displayable in a window of said graphical user
interface,
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f. a sub-modifier menu stored on said data storage device
and displayable in a window of said graphical user
interface, and

g. application software for generating a second menu from
said first menu and transmitting said second menu to a
wireless handheld computing device or Web page,

wherein the application software facilitates the generation of the second menu by allowing
selection of catagories and items from the first menu, addition of menu categories to the second
menu, addition of menu items to the second menu and assignment of parameters to items in the
second menu using the graphical user interface of said operating system, said parameters being
selected from the modifier and sub-modifier menus.

& }/l’ An information management and synchronous communications system in
accordance with claim )(6' wherein the second menu is a restaurant menu.

; }2’ An information management and synchronous communications system in
accordance with claim}@,’whcrcin the second menu is capable of being displayed on the display
screen of a wireless computing device.

4/3‘ An_information management and synchronous communications system in
accordance with claim }2/ wherein selections from the second menu are capable of being
transmitted to a receiving computer by wireless link.

b}/ An information management and synchronous communications system in
accordance with claim}Kwhercin the second menu is capable of being displayed on display
screens of computers in a network.

7z,

/}5.’ An information management and synchronous communications system in

accordance with claim/% wherein the computer network is the internet.

-31-
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1 /}6 An information management and synchronous communications system in
2 accordance with claim% wherein selections from the second menu are capable of being
3 transmitted to a receiving computer via the interet.

4 g}?’ An information management and synchronous communications system in
5 accordance with claim 207 wherein the second menu is created in conformity with hypertext
6 markup language or extensible markup language.

7 ?28’ An information management and synchronous communications system in

{

8 accordance with claim )O' wherein the second menu overwrites the first menu.

= 9 / /}9( The information management and synchronous communications system of
ﬁo claim}éf wherein the first menu and the second menu are both capable of being displayed in the
= , .

=1 same window on the display screen.

¥ /1 o -

M2 }Pf The information management and synchronous communications system of
E.i-;

:_5{3 claim}ﬁf wherein the menu categories and items comprising the second menu are subsets,
bt

34 respectively, of the menu categories and items comprising the first menu.

31. In a computer system having an inppt device, a storage device, a video

18 a. outputting at least one window on the video display;

19 ! b. outputting a first meny in a window on the video

20 display;
21 | c. displaying a cursor onythe video display;
22 \ d. selecting items from the first menu with the input
23 device or the graphjcal user interface;
24 l e. inserting the itemp selected from the first menu into a
25 | second menu, the second menu being output in a
26 | window;
Z\-\h—
T -32-
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first menu to the second mgnu using the input device or
the graphical user interfack; and

( f. optionally adding additional items not included in the

g. storing the second meny on the storage device.

32.\, The method of claim 31, further comprising the step of transferring data or

. additional items are inserted into a sedond menu which is displayed in the same window as the

first menu. g

35.  The method of claim 32, comprising the further steps of selecting at least
one item from the second menu and transmitting'at least one item selected to another computer.

36. The method of claim 35, erein at least one item selected from the
second menu is transmitted to another computer by wirgless link or the internet.

37.  The method of claim 32, wherein the second menu is displayed on the
remote digital device or Web page in page format.

38. The method of claim 31, wherein the s&cond menu overwrites the first
menu.

39.  The method of claim 31, wherein the items coyprising the second menu

are a subset of the items comprising the first menu.

— zr

)9’. An information management and synchronous communications system for
use with wireless handheld computing devices and the internet comprising:

a. acentral database containing hospitality applications and data,

33 -
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b. at least one wireless handheld computing device on which hospitality
applications and data are stored,
¢. at least one Web server on which hospitality applications and data are
stored,
d. at least one Web page on which hospitality applications and data are
stored,
e. an application program interface, and
f. a communications control module,
wherein applications and data are synchronized between the central data base, at least one
wireless handheld computing device, at least one Web server and at least one Web page; wherein
the application program interface enables intergration of outside applications with the hospitality
applications and wherein the communications control module is an interface between the
hospitality applications and any other communications protocol.
1% : . .
}l( The information management and synchronous communications system of
claim }(&:vherein the communications control module provides a single point of entry for all
hospitality applications and wherein the single point of entry allows the synchronization of at
least one wircless handheld computing device and at least one Web page with the central
database so that at least one handheld device, at least one Web page and central database are
consistent. / ?
, ; }2’ The information management and synchronous communications system of
claim }d’ wherein information entered on at least one Web page and transmitted over the internet

1S automatically communicated to the central database and at least one wireless handheld

computing device.
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/3 43" The information management and synchronous communications system of
2 claim 4 wherein information entered on at least one wireless handheld computing device is

3 automatically communicated to the central database and at least one Web page.
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ABSTRACT
An information management and synchronous communications system and
method facilitates database equilibrium and synchronization with wired, wireless and Web-based
systems, user-friendly and efficient generation of computerized menus and reservations for
restaurants and other applications that utilize equipment with nonstandard graphical formats,
display sizes and/or applications for use in remote data entry, information management and
communication with host computer, digital input device or remote pager via standard hardwired

connection, the intermet, a wireless link or the like.
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Docket No. 3125-4002

COMBINED DECLARATION AND POWER OF ATTORNEY FOR
ORIGINAL, DESIGN, NATIONAL STAGE OF PCT, SUPPLEMENTAL
DIV [ION-IN-PART ICATI

As a below name inventor, [ hereby declare that:

—

My residence, post office address and citizenship are as stated below next to my name,

I believe 1 am the original, first and sole inventor (if only one name is listed below) or an original, first and joint
inventor (if plural names are listed below) of the subject matter which is claimed and for which a patent is sought on
the invention entitled:

INFORMATION MANAGEMENT AND SYNCHRONOUS COMMUNICATIONS SYSTEM WITH MENU
GENERATION
the specification of which

a. [ X] is attached hereto

b. [ ] wasfiled on as application Serial No. _ and was amended on
- (if applicable).

PCT FILED APPLICATION ENTERING NATIONAL STAGE

c. [ ] wasdescribed and claimed in International Application No. filedon __ and
as amended on __ ) . (if any).

[ hereby state that I have reviewed and understand the contents of the above-identified specification, including the
claims, as amended by any amendment referred to above.

[ acknowledge the duty to disclose information which is material to the patentability as defined in Title 37, Code of
Federal Regulations, § 1.56.

[ hereby specify the following as the correspondence address to which all communications about this application are
to be directed:

SEND CORRESPONDENCE TO: MORGAN & FINNEGAN, L.L.P
345 Park Avenue
New York, N.Y. 10154

DIRECT TELEPHONE CALLS TO:
(212) 758-4800

[ 1 I hereby claim foreign priority benefits under Title 35, United States Code § 119(a)-(d) or under
§ 365(b) of any foreign application(s) for patent or inventor’s certificate or under § 365(a) of any PCT international
application(s) designating at least one country other than the U.S. listed below and also have identified below such
foreign application(s) for patent or inventor’s certificate or such PCT international application(s) filed by me on the
same subject matter having a filing date within twelve (12) months before that of the application on which priority is
claimed:

[ 1 The attached 35 U.S.C. § 119 claim for priority for the application(s} listed below forms a part of this
declaration.
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Application Date of filing Date of Issue Priority

Country/PCT _Number {day. month, yr) (day. month, yr) Claimed
[1YES [ |NO
[ 1YES [ INO

[ IYES [ ]NO

{ 1 I hereby claim the benefit under 35 U.S.C. § 119(e) of any U.S. provisional application(s) listed below.

visiona lication No. D f Fili

ADDITIONAL STATEMENTS FOR DIVISIONAL, CONTINUATION OR CONTINUATION-IN-PART
OR PCT INTERNATIONAL APPLICATION(S) (DESIGNATING THE U.S.)

[ hereby claim the benefit under Title 35, United States Code § 120 of any United States application(s) or under
§ 365(c) of any PCT international application(s) designating the U.S. listed below.

US/PCT Application Serial No. Filing Date Startus (patented, pending, abandoned)/
U.S. application no. assigned (For PCT)

US/PCT Application Serial No. Filing Date Status (patented, pending, abandoned)/
U.S. application no. assigned (For PCT)

[ ] In this continuation-in-part application, insofar as the subject matter of any of the claims of this
application is not disclosed in the above listed prior United States or PCT international application(s) in the manner
provided by the first paragraph of Title 35, United States Code, § 112, I acknowledge the duty to disclose material
information as defined in Title 37, Code of Federal Regulations, § 1.56(a) which occurred between the filing date of
the prior application(s) and the national or PCT international filing date of this application.

[ hereby declare that all statements made herein of my own knowledge are truc and that all statements made on
information and belief are believed to be true; and further that these statements were made with the knowledge that
willful false statements and the like so made are punishable by fine or Imprisonment, or both, under Section 1001 of
Title 18 of the United States Code and that such willful false statements may jeopardize the validity of the
application or any patent issued thereon.

[ hereby appoint the following attorneys and/or agents with full power of substitution and revocation, to prosecute
this application, to receive the patent, and to transact all business in the Patent and Trademark Office connected
therewith: John A. Diaz (Reg. No. 19,550), John C. Vassil (Reg. No. 19,098), Alfred P. Ewert (Reg. No. 19,887),

2.
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pavid H. Pfeffer (Reg. No. 19,825), Harry C. Marcus (Reg. No. 22,390), Robert E. Paulson (Reg. No. 21,046),
Stephen R. Smith (Reg. No. 22,615), Kurt E. Richter (Reg. No. 24,052), J. Robert Dailey (Reg. No. 27,434), Eugene
Moroz (Reg. No. 25,237), John F. Sweeney (Reg. No. 27,471), Amold I. Rady (Reg. No. 26,601), Christopher A.
Hughes (Reg. No. 26,914), William S. Feiler (Reg. No. 26,728), Joseph A. Calvaruso (Reg. No. 28,287), James W.
Gould (Reg. No. 28,859), Richard C. Komson (Reg. No. 27,913), Israel Blum (Reg. No. 26,710), Bartholomew
verdirame (Reg. No. 28,483), Maria C.H. Lin (reg. No. 29,323}, Joseph A. DeGirolamo (Reg. No. 28,595), Michael
P. Dougherty (Reg. No. 32,730), Seth J. Atlas (Reg. No. 32,454), Andrew M. Riddles (Reg. No. 31,657), Bruce D.
DeRenzi (Reg. No. 33,676), Michael M. Murray (Reg. No. 32,537), Mark J. Abate (Reg. No. 32,527), Alfred L.
Haffner, Jr. (Reg. No. 18,919), Harold Haidt (Reg. No. 17,509), John T. Gallagher (Reg. No. 35,516), Steven F.
Meyer (Reg. No. 35,613) and Kenneth H. Sonnenfeld (Reg. No. 33,285) of Morgan & Finnegan, L.L.P. whose
address 1s: 345 Park Avenue, New York, New York, 10154; and Edward A. Pennington (Reg. No. 32,588), Michael
S. Marcus (Reg. No. 31,727) and John E. Hoel (Reg. No. 26,279) of Morgan & Finnegan, L.L.P., whose address is

1775 Eye Street, Suite 400, Washington, D.C. 20006.

[] [ hereby authorize the U.S. attorneys and/or agents named hereinabove to accept and follow instructions

from

as to any action to be taken in the U.S. Patent and Trademark Office

regarding this application without direct communication between the U.S. attorneys and/or agents and me.
In the event of a change in the person(s) from whom instructions may be taken I will so notify the U.S.

attorneys and/or agents hereinabove.

Full name of sole or first inventor  Keith R. McNally

Inventor’s signature*

Residence 21567 Parvin Drive, Santa Clarita, CA 91350

Citizenship USA

Post Office Address

Full name of second joint inventor, if any ~ William H. Roof

Inventor’s signature®

date
Residence 13429 Luckett Court, San Diego, CA 92130

Citizenship USA

Post Office Address

Full name of third joint inventor, ifany  Richard Bergfeld

Inventor's signature®

date
Residence 20719 Nashville Court, Chatsworth, CA 91311

Citizenship  USA
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Post Office Address

[1] ATTACHED IS/ARE ADDED PAGE(S) TO COMBINED DECLARATION AND POWER OF
ATTORNEY FORM FOR SIGNATURE BY FOURTH AND SUBSEQUENT INVENTORS

* Before signing this declaration, each person signing must:
1. Review the declaration and verify the correctness of all information therein; and

2. Review the specification and the claims, including any amendments made to the claims.
After the declaration is signed, the specification and claims are not to be altered.

To the inventor(s):

The following are cited in or pertinent to the declaration attached to the accompanying application:

itle 37 f Federal Regulati
Duty 1o disclose information material to patentability.

(a) A patent by its very nature is affect with a public interest. The public interest is best served, and
the most effective patent examination occurs when, at the time an application is being examined, the Office
is aware of and evaluates the teachings of all information material to patentability. Each individual
associated with the filing and prosecution of a patent application has a duty of candor and good faith in
dealing with the Office, which includes a duty to disclose to the Office all information known to that
individual to be material to patentability as defined in this section. The duty to disclose information exists
with respect to each pending claim until the claim is canceled or withdrawn from consideration, or the
application becomes abandoned. Information material to the patentability of a claim that is canceled or
withdrawn from consideration need not be submitted if the information is not material to the patentability
of any claim remaining under consideration in the application. There is no duty to submit information
which is not material to the patentability of any existing claim. The duty to disclose all information known
to be material to patentability is deemed to be satisfied if all information known to be material to
patentability of any claim issued in patent was cited by the Office or submitted to the Office in the manner
prescribed by §§1.97(b)-(d) and 1.98. However, no patent will be granted on an application in connection
with which fraud on the Oftice was practiced or attempted or the duty of disclosure was violated through
bad faith or intentional misconduct. The Office encourages applicants to carefully examine:

8)) prior art cited in search reports of a foreign patent office in a counterpart application, and
(2) the closest information over which individuals associated with the filing or prosecution of

a patent application believe any pending claim patentably defines, to make sure that any
material information contained therein is disclosed to the Office.
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Title 35, U.S. Code § 101

Inventions patentable

Whoever invents or discovers any new and useful process, machine, manufacture, or composition of
matter, or any new and useful improvement thereof, may obtain a patent therefor, subject to the conditions and
requirements of ths title.

Title 35 U.S. Code § 102
Conditions for patentability; novelty and loss of right to patent

A person shall be entitled to a patent unless —

(a) the invention was known or used by others in this country, or patented or described in a printed
publication in this or a foreign country, before the invention thereof by the applicant for patent,

(b) the invention was patented or described in a printed publication in this or foreign country or in
public use or on sale in this country, more than one year prior to the date of application for patent in the United
States, or

(c) he has abandoned the invention, or

(d) the invention was first patented or caused to be patented, or was the subject of an inventor’s
certificate, by the applicant or his legal representatives or assigns in a foreign country prior to the date of the
application for patent in this country on an application for patent or inventor's certificate field more than twelve
months before the filing of the application in the United States, or

(e) the invention was described in a patent granted on an application for patent by another filed in the
United States before the invention thereof by the applicant for patent, or on an international application by another
who has fulfilled the requirements of paragraphs (1), (2), and (4) of section 371(c) of this title before the invention
thereof by the applicant for patent, or

(N he did not himself invent the subject matter sought to be patented, or
(g) before the applicant’s invention thereof the invention was made in this country by another had not
abandoned, suppressed, or concealed it. In determining priority of invention there shall be considered not only the

respective dates of conception and reduction to practice of the invention, but also the reasonable diligence of one
who was first to conceive and last to reduce to practice, from a time prior to conception by the other ...

Title 35, U.S. Code § 103

Conditions for patentability; non-obvious subject matter

A patent may not be obtained though the invention is not identically disclosed or described as set forth in
section 102 of this title, if the differences between the subject matter sought to be patented and the prior art are such
that the subject matter as a whole would have been obvious at the time the invention was made to a person having
ordinary skill in the art to which said matter pertains. Patentability shall not be negatived by the manner in which
the invention was made.

Subject matter developed by another person, which qualifies as prior art only under subsection (f) or (g) of
section 102 of this title, shall not preclude patentability under this section where the subject matter and the claimed

-5-
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invention were, at the time the invention was made, owned by the same person or subject to an obligation of
assignment to the same person.

de § 112 (in pa

Speciﬁcalinn

The specification shall contain a written description of the invention, and of the manner and process of
making and using it, in such full, clear, concise and exact terms also enable any person skilled in the art to which it
pertains, or with which it 1s mostly nearly connected, to make and use the same, and shall set forth the best mode

contemplated by the inventor of carrying out his invention.

Title 35, U.S. Code § 119
Benefit of earlier filing date in foreign country; right of priority

An application for patent for an invention filed in this country by any person who has, or whose legal
representatives or assigns have, previously regularly filed an application for a patent for the same invention in a
foreign country which affords similar privileges in the case of applications filed in the United States or to citizens of
the United States, shall have the same effect as the same application would have if filed in this country on the date
on which the application for patent for the same invention was first filed in such foreign country, if the application in
this country is filed within twelve months from the earliest date on which such foreign application was filed; but no
patent shall be granted on any application for patent for an invention which had been patented or described in a
printed publication in any country more than one year before the date of he actual filing of the application in this
country, or which had been in public use or on sale in this country more than one year prior to such filing.

it S. 2
Benefit or earlier filing date in the United States
An application for patent for an invention disclosed in the manner provided by the first paragraph of section
112 of this title in an application previously filed in the United States, or as provided by section 363 of this title,
which is filed by an inventor or inventors named in the previously filed application shall have the same effect, as to
such invention, as though filed on the date of the prior application, if filed before the patenting or abandonment of or

termination of proceedings on the first application or an application similarly entitled to the benefit of the filing date
of the first application and if it contains or is amended to contain a specific reference to the earlier filed application.

Please read carefully before signing the Declaration attached to the accompanying Application.

If you have any questions, please contact Morgan & Finnegan, [.L.P.

FORM:COMB-DEC.NY
Rev. 5/21/98
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Applicant(s) ] Keith R. McNally et al. Group Art Unit: TBA
Serial No. i TBA Examiner: TBA
Filed E September 21, 1999
For 3 INFORMATION MANAGEMENT AND SYNCHRONOUS
COMMUNICATIONS SYSTEM WITH MENU GENERATION
STATEMENT (DECLARATION) CLAIMING SMALL ENTITY STATUS
— 37 CFR §1.97(f) AND §1.27 (c)) - SMALL BUSINESS CONCERN
I hereby state that [ am
[1] the owner of the small business concern identified below:
[X] an official of the small business concemn empowered to act on behalf of the concern identified
below

NAME OF CONCERN AMERANTH TECHNOLOGY SYSTEMS, INC.

ADDRESS OF CONCERN 12230 El Camino Real, Suite 330; San Diego, California 92130-2090

I hereby state that the above identified small business concern qualifies as a small business concern as defined in 13
CFR §§ 121.3-18, and reproduced in 37 CFR § 1.9(d), for purposes of paying reduced fees under section 41(a) and
(b) of Title 35, United States Code, in that the number of employees of the concemn, including those of its affiliates,
does not exceed 500 persons. For purposes of this statement, (1) the number of employees of the business concern
is the average over the previous fiscal year of the concem of the persons employed on a full-time, part-time or
temporary basis during each of the pay periods of the fiscal year, and (2) concemns are affiliates of each other when
either, directly or indirectly, one concern controls or has the power to control the other, or a third party or parties
controls or has the power to control both. I hereby state that exclusive rights under contract or law have been
conveyed to and remain with the small business concern identificd above with regard to the invention entitled:

INFORMATION MANAGEMENT AND SYNCHRONOUS by: Keith R. McNally
COMMUNICATIONS SYSTEM WITH MENU GENERATION William H. Roof;

Richard Bergfeld
inventor(s)

“described in

[X] the specification filed herewith
[] application Serial No. , filed
[] Patent No. , issued
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SENT gY: MIRGAN & FINKEGAN '3"2;1'3.1 ©4120°W  MORGAN & FIM: [AN- Gt 73482177k

E Docket No. 3125-4002
I

1f the rights held by the above idencified small businags cancesn are not exclusive, each individual, concem or
ganization having rights ic the invention is listed below and no rights to the mvention are held by any person.

other than the inventor, who could not qualify a3 an independent invenror under 37 CFR 1.9(c) if that person mads

the invention, or by any concern which would not qualify as a small business concern vader 37 CFR 1.9(d), or a

nonprofit arganization under 37 CFR 1.9(¢).

NAME NiA
.ﬂbbksss .
l - T Indwidaal T[] Srasll Businsss Concern T Nomprofit Orgaaization
ME
DRESS
{1 Todvidaal 1] Small Business Concern [1] Nonproflt Organizition

I kcknowladge the duty to file, in this application or patent, notificatian of any change in status resulting (n loss of
ertitlepent a erasl] entity status pricr to paying, or at the time of paying, the earlicet of the issus fee o7 agy
maintenance fee due after the date on which statns as & small entity is no longer sppropriate. (37 C.F.R. 1.28(b))

NAME OF PERSON SIGNING _ Keith R. McNally
|

ﬂlme OF PERSON IF OTHER THAN OWNER  Chief Pxecutive Officer

DRESS OF PERSON SIGNING

21567 Parvin Drive, Santalavita, California p13567 —~——77
ATURE /ﬁ& p : DATE T-Zo =-T<

FORM: SMALLBUS
Rév. 05726908

‘ NOTE: Separate surements aro required from each namme person, Concern or arganization having rights to
the inventian averring to their swatus as 1raall entities. (37 CFR 1.27).

H 12-
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Flame broded brandy marinated Tender Chicken Breast w
1¢]topped with a creamy clantro sauce. Seived with .
i, | steamed broccoli. carrots and zucchini.
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o
f'y q\ UNITED STATES LEPARTMENT OF COMMERCE

. . | Patent and Trademark Office >
x Address: COMMISSIONER OF PATENTS AND TRADEMARKS -7}’"
# Washington, D.C. 20231

Emrm NUMBER l FILING/RECEIPT DATE I FIRST NAMED APPLICANT | ATTORNEY DOCKET NOJTITLE ]

AEOANUL AL T e MONGL C RS TIY

L g
TR RV TATIN R S i (VIO IR U S O
1775 EYE
WESE I MGETTOR O Prdie

TSR I Tl [ =

GTREET 5Th Jadi

DATE MAILED:

NOTICE TO FILE MISSING PARTS OF APPLICATION
Filing Date Granted

AnApplication Number and Filing Date have been assigned to this application. The items indicated below, however, are missing. Applicant
Is given TWO MONTHS FROM THE DATE OF THIS NOTICE within which to file all required items and pay any fees required below to
‘awoid abandonment. Extensions of time may be obtained by filing a petition accompanied by the extension fee under the provisions of
-§7CFR 1:136(a). if any of items 1 or 3through 5 are indicated as missing, the SURCHARGE set forth in 37 CFR 1.16(e) of (1'$65.00
for a small entity in compliance with 37 CFR 1.27, or ] $130.00 for a non-small entity, must aiso be timely submitted in reply
to this NOTICE to avoid abandonment.

¥ al required items on this form are filed within the period set abovg, the total amount owed by applicant as a

entity (statement filed) [] non-small entity is $___/ - (s
[ 1. The statutory basic filing fee is:
O missing.
O insufficient.
Applicant must submit § to complete the basic filing fee and/or file a small entity statement

claiming such status (37 CFR 1.27).
O 2. The following additional claims fees are due:

3 for total claims over 20.

$ for. independent claims over 3.

for multiple dependent claim surcharge.
nt must either submit the additional claim fees or cancel additional claims for which fees are due.

oath or declaration:

is missing or unsigned.

[0 does not cover the newly submitted items.

An oath or declaration in compliance with 37 CFR 1. 63, including residence information and identifying the application by
the above Application Number and Filing Date is required.

O 4. The signature(s) to the oath or declaration is/are by a person other than inventor or person qualified under 37 CFR 1.42,
1.43 or 1.47.

A properly signed oath or declaralion in compliance with 37 CFR 1.63, identifying the application by the above
Application Number and Filing Date, is required.

0 5. The signature of the following joint inventor{s) is missing from the oath or declaration:

An oath or declaration in compliance with 37 CFR 1.63 listing the names of all inventors and signed by the omitted
inventor(s), identifying this application by the above Application Number and Filing Date, is required.

O 6. A $50.00 processing fee is required since your check was returned without payment (37 CFR 1.21(m)).

0 7. Your filing receipt was mailed in error because your check was returned without payment.

8. The application was filed in a language other than English.

Applicant must file a verified English translation of the application, the $130.00 set forth in 37 CFR 1.17(k), unless
previously submitted, and a statement that the translation is accurate (37 CFR 1.52(d)).

0 9. 0THER: ] ~

Diroct the reply and any questions about this notice to “Attention: Box Missing Parts.”
A copy of this notice MUST be returned with the reply.
A

~—— - + sl “; =
Customer Service Center

nial Patent Examination Digision (703) 308-1202

U'S GPO 1999 450-5875
FORM PTO-1533 (REV. 598}
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w Docket No. 3125-4002 #3

IN THE UNITED STATES PATENT AND TRADEMARK OFFICE

—

Applicant : Keith R. McNally Group Art Unit: 2776
William H. Roof
Richard Bergfeld

Serial No. : 09/400,413 Examiner: To Be Assigned
Filed : September 21, 1999
For : INFORMATION MANAGEMENT AND SYNCHRONOUS

COMMUNICATIONS SYSTEM WITH MENU GENERATION

RESPONSE TO NOTICE TO FILE MISSING PARTS OF APPLICATION

Assistant Commissioner for Patents
Box Missing Parts

Washington, D.C. 20231

Sir:

In response to the Notification of Missing Requirements Under 35 U.S.C. §371, enclosed
are: 1) a copy of the Notification of Missing Requirements Under 35 U.S.C. §371 dated October
14, 1999; 2) an executed Declaration and Power of Attorney; and 3) a check in the amount of
$65.00 for the surcharge.

Applicants have previously filed a Statement {Declaration) Claiming Small Entity Status.

In the event that an extension of time is required, or which may be required in addition to

that requested in a petition for an extension of time, the Commissioner is requested to grant a

petition for that extension of time which is required to make this response timely and is hereby

507015_1
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Ducket No. 3125-4002

authorized to charge any fee for such n of time or credit any over payment for an
extension of time to Deposit Account No. 13-4500, Order No. 3125-4002. A DUPLICATE
COPY OF THIS PAPER IS ENCLOSED.

Respectfully submitted,

By:J %OC\ O/’Cl,

oﬂw. Osbome
Date: December 13, 1999 Registration No. 36,231

Morgan & Finnegan L.L.P.
345 Park Avenue

New York, NY 10154
(212) 7584800

;. 507015 1 .
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§ Docket No. 3125-4002
c‘
COMBINED DECLA

OWER OF ATTORNEY FOR # 2
ORIGINAL, DESIGN, NATI AGE OF PCT, SUPPLEMENTAL

DIVISIONAL, CONTINUATION OR CONTINUATION-IN-PART APPLICATION

As a below name inventor, [ hereby declare that:
My residence, post office address and citizenship are as stated below next to my name,

I believe I am the original, first and sole inventor (if only one name is listed below) or an original, first and joint
inventor (if plural names are listed below) of the subject matter which is claimed and for which a patent is sought on
the invention entitled:

INFORMATION MANAGEMENT AND SYNCHRONOUS COMMUNICATIONS SYSTEM WITH MENU

GENERATION
the specification of which

a. [ ] isattached hereto

b. [X] was filed on September 21, 1999 as application Serial No. 09/400,413 and was amended on
. (if applicable).

PCT FILED APPLICATION ENTERING NATIONAL STAGE

c. [ ] wasdescribed and claimed in International Application No. ~_ filedon and
as amended on . . (ifany).

[ hereby state that I have reviewed and understand the contents of the above-identified specification, including the
claims, as amended by any amendment referred to above.

I acknowledge the duty to disclose information which is material to the patentability as defined in Title 37, Code of

Federal Regulations, § 1.56.
————

I hereby specify the following as the correspondence address to which all communications about this application are
to be directed:

SEND CORRESPONDENCE TO: MORGAN & FINNEGAN, L.LL.P
345 Park Avenue
New York, N.Y. 10154

DIRECT TELEPHONE CALLS TO:
(212) 758-4800

[ 1 I hereby claim foreign priority benefits under Title 35, United States Code § 119(a)-(d) or under
§ 365(b) of any foreign application(s) for patent or inventor’s certificate or under § 365(a) of any PCT international
application(s) designating at least one country other than the U.S. listed below and also have identified below such
foreign application(s) for patent or inventor’s certificate or such PCT intermational application(s) filed by me on the
same subject matter having a filing date within twelve (12) months before that of the application on which priority is

claimed:

[ ] The attached 35 U.S.C. § 119 claim for priority for the application(s) listed below forms a part of this
declaration.

492351 _1
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Application Date of filing Date of Issue Priority
Country/PCT Number (day, month, yr} (day, month. yr) Claimed

[]YES [ ]NO

[ ] YES [ ]NO

[ ]1YES [ ]NO

[ ] I'hereby claim the benefit under 35 U.S.C. § 119(e) of any U.S. provisional application(s) listed below.

Provisional Application No. Date of Filing (day, month, yr)

ADDITIONAL STATEMENTS FOR DIVISIONAL, CONTINUATION OR CONTINUATION-IN-PART
OR PCT INTERNATIONAL APPLICATION(S) (DESIGNATING THE U.S.)

I hereby claim the benefit under Title 35, United States Code § 120 of any United States application(s) or under
§ 365(c) of any PCT international application(s) designating the U.S. listed below.

US/PCT Application Serial No. Filing Date Status (patented, pending, abandoned)/
U.S. application no. assigned (For PCT)

US/PCT Application Serial No. Filing Date Status (patented, pending, abandoned)/
U.S. application no. assigned (For PCT)

[ ] In this continuation-in-part application, insofar as the subject matter of any of the claims of this
application is not disclosed in the above listed prior United States or PCT international application(s) in the manner
provided by the first paragraph of Title 35, United States Code, § 112, I acknowledge the duty to disclose material
information as defined in Title 37, Code of Federal Regulations, § 1.56(a} which occurred between the filing date of
the prior application(s) and the national or PCT international filing date of this application.

I hereby declare that all statements made herein of my own knowledge are true and that all statements made on
information and belief are believed to be true; and further that these statements were made with the knowledge that
willful false statements and the like so made are punishable by fine or Imprisonment, or both, under Section 1001 of
Title 18 of the United States Code and that such willful false statements may jeopardize the validity of the
application or any patent issued thereon.

I hereby appoint the following attomeys and/or agents with full power of substitution and revocation, to prosecute
this application, to receive the patent, and to transact all business in the Patent and Trademark Office connected
therewith: John A. Diaz (Reg. No. 19,550}, John C. Vassil (Reg. No. 19,098), Alfred P. Ewert (Reg. No. 19,887),

2
492351 _1

Apple, Exhibit 1010, Page 66




David H. Pfeffer (Reg. No. 19,825}, Harry C. Marcus (Reg. No. 22,390), Robert E. Paulson (Reg. No. 21,046),
Stephen R. Smith (Reg. No. 22,615), Kurt E. Richter (Reg. No. 24,052), J. Robert Dailey (Reg. No. 27,434), Eugene
Moroz (Reg. No. 25,237), John F. Sweeney (Reg. No. 27,471), Amold I. Rady (Reg. No. 26,601), Christopher A.
Hughes (Reg. No. 26,914), William S. Feiler (Reg. No. 26,728), Joseph A. Calvaruso (Reg. No. 28,287), James W.
Gould (Reg. No. 28,859), Richard C. Komson (Reg. No. 27,913), Israel Blum (Reg. No. 26,710), Bartholomew
Verdirame (Reg. No. 28,483), Maria C.H. Lin (reg. No. 29,323), Joseph A. DeGirolamo (Reg. No. 28,595), Michael
P. Dougherty (Reg. No. 32,730), Scth J. Atlas (Reg. No. 32,454), Andrew M. Riddles (Reg. No. 31,657), Bruce D.
DeRenzi (Reg. No. 33,676), Michael M. Murray (Reg. No. 32,537), Mark J. Abate (Reg. No. 32,527), Alfred L.
Haffner, Jr. (Reg. No. 18,919), Harold Haidt (Reg. No. 17,509), John T. Gallagher (Reg. No. 35,516), Steven F.
Meyer (Reg. No. 35,613) and Kenneth H. Sonnenfeld (Reg. No. 33,285) of Morgan & Finnegan, L.L.P. whose
address is: 345 Park Avenue, New York, New York, 10154; and Edward A. Pennington (Reg. No. 32,588), Michael
S. Marcus (Reg. No. 31,727) and John E. Hoel (Reg. No. 26,279) of Morgan & Finnegan, L.L.P., whose address is
1775 Eye Steet, Suite 400, Washington, D.C. 20006.

[] I hereby authorize the U.S. attorneys and/or agents named hereinabove to accept and follow instructions
from

. as o any action to be taken in the U.S. Patent and Trademark Office
regarding this application without direct communication between the U.S. attomneys and/or agents and me.
In the event of a change in the person(s) from whom instructions may be taken I will so notify the U.S.
attorneys and/or agents hereinabove.

FyHname of sole or first inventor ; Keith R. McNally T —

Inventor’s signature* | Q ng&/j ]&/25,}?4
5/0 -3-342 )1):/4 @VL, .%ﬁ P;. d(% date 2

Residence

Citizenship USA

Post Office Address

s

1 name of second joint inventor, if any ~ WilliamH.Roof _ —
e Ll g 1025129
L I Li

date
Residence 13429 Luckett Court, San Diego, CA 92130

Citizenship USA

Post Office Address

el

ull name of third joint

by s 7//1
N 1ofestia

Inventor’s signature*
L L
date Y

Streaf
Residence 20719 Nashville @omrt. Chatsworth, CA 91311

Citizenship USA i S
3.
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Post Office Address

[1 ATTACHED IS/ARE ADDED PAGE(S) TO COMBINED DECLARATION AND POWER OF
ATTORNEY FORM FOR SIGNATURE BY FOURTH AND SUBSEQUENT INVENTORS

* Before signing this declaration, each person signing must:
1. Review the declaration and verify the correctness of all information therein; and

2, Review the specification and the claims, including any amendments made to the claims.
After the declaration is signed, the specification and claims are not to be altered.

To the inventor(s):

The following are cited in or pertinent to the declaration attached to the accompanying application:

Title 37, Code of Federal Regulation, § 1.56

Duty to disclose information material to patentability.

(a) A patent by its very nature is affect with a public interest. The public interest is best served, and
the most effective patent examination occurs when, at the time an application is being examined, the Office
is aware of and evaluates the teachings of all information material to patentability. Each individual
assoclated with the filing and prosecution of a patent application has a duty of candor and good faith in
dealing with the Office, which includes a duty to disclose to the Office all information known to that
individual to be material to patentability as defined in this section. The duty to disclose information exists
with respect to each pending claim until the claim is canceled or withdrawn from consideration, or the
application becomes abandoned. Information material to the patentability of a claim that is canceled or
withdrawn from consideration need not be submitted if the information is not material to the patentability
of any claim remaining under consideration in the application. There is no duty to submit information
which is not material to the patentability of any existing claim. The duty to disclose all information known
to be material to patentability is deemed to be satisfied if all information known to be material to
patentability of any claim issued in patent was cited by the Office or submitted to the Office in the manner
prescribed by §§1.97(b)-(d) and 1.98. However, no patent will be granted on an application in connection
with which fraud on the Office was practiced or attempted or the duty of disclosure was violated through
bad faith or intentional misconduct. The Office encourages applicants to carefully examine:

(n prior art cited in search reports of a foreign patent office in a counterpart application, and

(2) the closest information over which individuals associated with the filing or prosecution of
a patent application believe any pending claim patentably defines, to make sure that any
material information contained therein is disclosed to the Office.

492351 |
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Title 35, U.S. Code § 101

Inventions patentable
Whoever invents or discovers any new and useful process, machine, manufacture, or composition of

matter, or any new and useful improvement thereof, may obtain a patent therefor, subject to the conditions and
requirements of this title.

Title 35 U.S. Code § 102

Conditions for patentability; novelty and loss of right to patent
A person shall be entitled to a patent unless —

(a) the invention was known or used by others in this country, or patented or described in a printed
publication in this or a foreign country, before the invention thereof by the applicant for patent,

(b) the invention was patented or described in a printed publication in this or foreign country or in
public use or on sale in this country, more than one year prior to the date of application for patent in the United
States, or

{c) he has abandoned the invention, or

(d) the invention was first patented or caused to be patented, or was the subject of an inventor’s

certificate, by the applicant or his legal representatives or assigns in a foreign country prior to the date of the
application for patent in this country on an application for patent or inventor's certificate field more than twelve
months before the filing of the application in the United States, or

(e) the invention was described in a patent granted on an application for patent by another filed in the
United States before the invention thereof by the applicant for patent, or on an international application by another
who has fulfilled the requirements of paragraphs (1), (2), and (4) of section 37 1(c) of this title before the invention
thereof by the applicant for patent, or

H he did not lumself invent the subject matter sought to be patented, or
(g) before the applicant’s invention thereof the invention was made in this country by another had not
abandoned, suppressed, or concealed it. In determining priority of invention there shall be considered not only the

respective dates of conception and reduction to practice of the invention, but also the reasonable diligence of one
who was first to conceive and last to reduce to practice, from a time prior to conception by the other ...

Title 35, U.S. Code § 103

Conditions for patentability; non-obvious subject matter

A patent may not be obtained though the invention is not identically disclosed or described as set forth in
section 102 of this title, if the differences between the subject matter sought to be patented and the prior art are such
that the subject matter as a whole would have been obvious at the time the invention was made to a person having
ordinary skill in the art to which said matter pertains. Patentability shall not be negatived by the manner in which
the invention was made.

Subject matter developed by another person, which qualifies as prior art only under subsection (f) or (g) of
section 102 of this title, shall not preclude patentability under this section where the subject matter and the claimed

-5-
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invention were, at the time the invention was made, owned by the same person or subject to an obligation of
assignment to the same person.

Title 35, U.S. Code § 112 (in part)

Specification

The specification shall contain a written description of the invention, and of the manner and process of
making and using it, in such full, clear, concise and exact terms also enable any person skilled in the art to which it
pertains, or with which it is mostly nearly connected, to make and use the same, and shall set forth the best mode
contemplated by the inventor of carrying out his invention.

Title 35, U.S. Code § 119

Benefit of earlier filing date in foreign country; right of priority

An application for patent for an invention filed in this country by any person who has, or whose legal
representatives or assigns have, previously regularly filed an application for a patent for the same invention in a
foreign country which affords similar privileges in the case of applications filed in the United States or to citizens of
the United States, shall have the same effect as the same application would have if filed in this country on the date
on which the application for patent for the same invention was first filed in such foreign country, if the application in
this country is filed within twelve months from the earliest date on which such foreign application was filed; but no
patent shall be granted on any application for patent for an invention which had been patented or described in a
printed publication in any country more than one year before the date of he actual filing of the application in this
country, or which had been in public use or on sale in this country more than one year prior to such filing.

Title 35, U.S. Code § 120

Benefit or earlier filing date in the United States

An application for patent for an invention disclosed in the manner provided by the first paragraph of section
112 of this title in an application previously filed in the United States, or as provided by section 363 of this title,
which is filed by an inventor or inventors named in the previously filed application shall have the same effect, as to
such invention, as though filed on the date of the prior application, if filed before the patenting or abandonment of or
termination of proceedings on the first application or an application similarly entitled to the benefit of the filing date
of the first application and if it contains or is amended to contain a specific reference to the earlier filed application.

Please read carefully before signing the Declaration attached to the accompanying Application.

If you have any questions, please contact Morgan & Finnegan, L.L.P.

FORM:COMB-DEC.NY
Rev. 5/21/98

-6-
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PATENT

Docket No. 3125-4002

IN THE UNITED STATES PATENT AND TRADEMARK OFFICE

Applicant(s) 3 Keith R. McNally Group Art Unit: 2776
William H. Roof
Richard Bergfeld
Serial No 3 09/400,413 Examiner: TBA
Filed ; September 21, 1999
For : INFORMATION MANAGEMENT AND SYNCHRONOUS

COMMUNICATIONS SYSTEM WITH MENU GENERATION

TRANSMITTAL OF DECLARATION PURSUANT TO C.F.R. § 1.53

ASSISTANT COMMISSIONER FOR PATENTS
Washington, D.C. 20231

Sir:
Transmitted herewith is a declaration for the above-identified application.

The surcharge, pursuant to 37 C.F.R. § 1.16(e), for filing a declaration on a date later than the
filing date of the application 15 as follows:
[X] Filing by a small entity
$65.00

[] Filing by other than a small entity
$130.00

[] Charge surcharge fee to Deposit Account No. 13-4500. Order No. _
A DUPLICATE COPY OF THIS SHEET IS ATTACHED.

[X] A check in the amount of $ 65.00 to cover the surcharge fee is enclosed.

509083 _1
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Docket No. 3125-4002
[X] The Assistant Commissioner is hereby authorized to charge any additional fees which

may be required by this paper, or credit any overpayment to Deposit Account No. 13-
4500. Order No.3125-4002. A DUPLICATE COPY OF THIS SHEET IS ATTACHED.

Respectfully submitted,

MORGAN & FINNEGAN, L.L.P.

Dated: December 13, 1999 By: % /(’V - O//é‘—‘k
Jo

M’. QOsborne
Registration No. 36,231

CORRESPONDENCE ADDRESS:

MORGAN & FINNEGAN, L.L.P.
345 Park Avenue

New York, New York 10154
(212) 758-4800

(212) 751-6849 Facsimile

509083_1
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‘g PATENT

& Docket No. 3125-4002
TEnTs S

IN THE UNITED STATES PATENT AND TRADEMARK OFFICE

Applicant(s) Keith R. McNally Group Art Unit: 2776
William H. Roof
Richard Bergfeld

Serial No : 09/400,413 Examiner: TBA
Filed : September 21, 1999
For : INFORMATION MANAGEMENT AND SYNCHRONOUS

COMMUNICATIONS SYSTEM WITH MENU GENERATION

ASSISTANT COMMISSIONER FOR PATENTS
Washington, D.C. 20231

Sir:
I hereby certify that the attached:

Transmittal of Declaration Pursuant to C.F.R. §1.53;
Combined Declaration and Power of Attomney;

Response to Notice To File Missing Parts of Application;
Notice To File Missing Parts of Application;

Check in the amount of $65.00; and

Return postcard.

S L, G b 1=

along with any paper(s) referred to as being attached or enclosed and this Certificate of Mailing are being deposited
with the United States Postal Service on date shown below with sufficient postage as first-class mail in an envelope
addressed to the: Assistant Commissioner for Patents, Washington, D.C. 20231.

Respectfully submirted,

MORGAN & FINNEGAN, L.L.P.

Dated: December 13, 1999

CORRESPONDENCE ADDRESS:
MORGAN & FINNEGAN LLP
345 Park Avenue

New York, New York 10154

(212) 758-4800

(212) 751-6849 Facsimile

509095 _1
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X‘w‘!\\ UNITED STATES D.PARTMENT OF COMMERCE
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An Application Number and Filing Date have been assigned to this application. Theitems indicated below, however, are missing. Applicant
is given TWO MONTHS FROM THE DATE OF THIS NOTICE within which to file all required items and pay any fees required below to
avoid abandonment. Extensions of time may be obtained by filing a petition accompanied by the extension fee under the pro[\g?ig;sff
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{J 1. The statutory basic filing fee is:
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A properly signed oath or declaration in compliance with 37 CFR 1.63, identifying the application by !he above
Application Number and Filing Date, is required.

[J s. The signature of the following joint inventor(s) is missing from the oath or declaration:

An oath or declaration in compliance with 37 CFR 1.63 listing the names of all inventors and signed by the omitted
inventor(s), identifying this application by the above Application Number and Filing Date, is required.
[J 6. A $50.00 processing fee is required sincé your check was returned without payment (37 CFR 1.21(m)).
O 7. Your filing receipt was mailed in error because your check was retumed without payment.
[0 8. The application was filed in a language other than English.
Applicant must file a verified English translation of the application, the $130.00 set forth in 37 CFR 1.17(k), unless
previously submitted, and a statement that the translation is accurate (37 CFR 1.52(d)).
{J 9. OTHER:

Direct the reply and any questions about this notice to “Attention: Box Missing Parts.”
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STIN THE UNITED STATES PATENT AND TRADEMARK OFFICE ”

Keith R. McNally Group Art Unit: 2776 _,
William H. Roof o
Richard Bergfeld g
Serial No 09/400,413

Examiner: TBA

Filed i September 21, 1999

- For :  INFORMATION MANAGEMENT AND SYNCHRONOUS ('_;_2
COMMUNICATIONS SYSTEM WITH MENU GENERATION

Assistant Commissioner for Patents
Washington, D.C. 20231

REQUEST TO CHANGE CORRESPONDENCE ADDRESS

Sir.:

Please change the correspondence address of record in the above-identified application

and direct all future correspondence to:

John W. Osborne
MORGAN & FINNEGAN, L.L.P. = -
345 Park Avenue 5. Wy =

New York, New York 10154 e o= -
Telephone No.: (212) 758-4800 =
Facsimile No.: (212) 751-6849 :

=t

13t

1

Respectfully submitted,
MORGAN & FINNEGAN, L.L.P.

Dated: December/3, 1999 By: QT/(‘/%’ . OM

Qohn W. Osborne
Reg. No. 36,231

MORGAN & FINNEGAN, L.L.P.
345 Park Avenue

New York, New York 10154
Tel(212) 758-4800

Fax.(212) 751-6849

507198 _1
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Docket No. 3125-4002 -
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IN THE UNITED STATES PATENT AND TRADEMARK OFFICE

Applicant(s)  : Keith R. McNally Group Art Unit: 2776
William H. Roof
Richard Bergfeld
Senal No : 09/400,413 Examiner: TBA
Filed g September 21, 1999
For : INFORMATION MANAGEMENT AND SYNCHRONOUS

COMMUNICATIONS SYSTEM WITH MENU GENERATION =

CERTIFICATE OF MAILING (37 C.F.R. 1.8a) ‘—i

ASSISTANT COMMISSIONER FOR PATENTS
Washington, D.C. 20231

Wz

SII [t}
I hereby certify that the attached:

1. Request To Change Correspondence Address; and
2. Return postcard.

along with any paper(s) referred to as being attached or enclosed and this Certificate of Mailing are being deposited
with the United States Postal Service on date shown below with sufficient postage as first-class mail in an envelope
addressed to the: Assistant Commissioner for Patents, Washington, D.C. 20231.

Respectfully submitted,

MORGAN & FINNEGAN, L.L.P.

Dated: December 13, 1999 W A 0 /C“\

Osbome
egistration No. 36,231

CORRESPONDENCE ADDRESS:
MORGAN & FINNEGAN LLP
345 Park Avenue

New York, New York 10154

(212) 758-4800

(212) 751-6849 Facsimile

509073 1
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% . Patent and Trademark Office
5 f Address: COMMISSIONER OF PATENTS AND TRADEMARKS
S7ares OF Washington, D.C. 20231 J
| APPLICATIONNO. | FILING DATE | FIRST NAMED INVENTOR | arrornev pockeTno. |
r = ] EXAMINER ]
T 1 | ART UNIT [ paper numBer |
* - S
it
DATE MAILED:

Please find below and/or attached an Office communication concerning this application or
proceeding.

Commissioner of Patents and Trademarks

(e_

PT0-90C (Rev. 2/95) 1- File Copy
“U.S. GPO: 2000-473-000/44602
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?ppllcailm Nc;__ ApPil. ...uS)
. . 09/400,413 McNally et al.
i Office Action Summary T AT
Cao "Kevin” Nguyen 2173

X Responsive to communication(s) filed on 9/21/99

i

~ This action is FINAL. [

i since this application is in condition for allowance except for formal matters, prosecution as to the merits is closed I
in accordance with the practice under Ex parte Quay¥935 C.D. 11; 453 0.G. 213.

A shortened statutory period for response to this action is set to expire 3 month(s), or thirty days, whichever is '
tonger, from the mailing date of this communication. Failure to respond within the period for response will cause the |
application to become abandoned. (35 U.S.C. § 133). Extensions of time may be obtained under the provisions of

17 CFR 1.136(a).

pisposition of Clain
X Claim(s) 1-43

Of the above, claim(s)

isfare pending in the ap;

is/fare withdrawn from consider |

Claim{s) 20-30 and 40-43

is/are allowed.

X
X Claim(s)1-19 and 31-39

is/are rejected

— ! Claim(s)

isfare objected

_ Claims

Application Papers

_ The drawing(s) filed on

— The specification is objected to by the Examiner.

__ The oath or declaration is objected to by the Examiner.

Priority under 35 U.S.C. § 119

_ Al
. received.
77 received in Application No. (Series Code/Serial Number)

_ BSome"

" The proposed drawing correction, filed on i

are subject to restriction or election requirern

X See the attached Notice of Draftsperson’s Patent Drawing Review, PTO-948.
is/are objected to by the Examiner.

approved | disapproved. .

" Acknowledgement is made of a claim for foreign priority under 35 U.S.C. § 119(a)-(d).
iNone of the CERTIFIED copies of the priority documents have been

—=

*Certified copies not received:

. received in this national stage application from the International Bureau (PCT Rule 17.2(a)).

Attachment(s)
X Notice of References Cited, PTO-892
__ Information Disclosure Statement(s), PTO-1449, Paper No(s).
— Interview Summary, PTO-413
X Notice of Draftsperson's Patent Drawing Review, PTO-948
£ Notice of Informal Patent Application, PTO-152

_. Acknowledgement is made of a claim for domestic priority under 35 U.S.C. § 118(e).

— SEE OFFICE ACTION ON THE FOLLOWING PAGES —

$ Pater ang Trademark Office

0-326 (Rev. 9-95) Office Action Summary

3art of Paper No. 5
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Application/Control Number: 09/400,413 Page 2

Art Umit: 2173

DETAILED ACTION

Claim Rejections - 35 USC § 102
1 The following is a quotation of the appropriate paragraphs of 35 U.S.C. 102 that form the

basis for the rejections under this section made in this Office action:

A person shall be entitled to a patent unless --

(e) the invention was described in a patent granted on an application for patent by another filed in the United
States before the invention thereof by the applicant for patent, or on an international application by another who
has fulfilled the requirements of paragraphs (1), (2), and (4) of section 371© of this title before the invention
thereof by the applicant for patent.

2. Claims 1-19 and 31-39 are rejected under 35 U.S.C. 102(e) as being anticipated by Cupps

et al. (5,991,739).

Regarding claim |, Cupps discloses an information management and synchronous
communications system for generating menus comprising: a central processing unit, a data
storage device connected to said central processing unit, an operating system including a graphical
user interface (see figure 2), a first menu stored on said data storage device, application software
for generating a second menu from said first menu, wherein the application software facilitates the
generation of the second menu by allowing selection of items from the first menu, addition of
items to the second menu and assignment of parameters to items in the second menu using the

graphical user interface of said operating system (see col. 9, lines 42-67),
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Art Unit: 2173

Regarding claim 2, Cupps discloses an information management and synchronous
communications system, wherein the second menu is a restaurant menu (see col. 5, lines 27-67).

Regarding claim 3, Cupps discloses an information management and synchronous
communications system, wherein the second menu is capable of being displayed on the display
screen of a wireless computing device (see col. 4, lines 1-55).

Regarding claims 4 and 5, Cupps discloses an information management and synchronous
communications system, wherein selections from the second menu are capable of being
transmitted to a receiving computer by wireless link.(see figures 1-2).

Regarding claims 6 and 7, Cupps discloses an information management and synchronous
communications system in, wherein the computer network is the internet; and selections from the
second menu are capable of being transmitted to a receiving computer via the internet (see col. 9,
lines 16-65 and figure 8-10).

Regarding claims 8-11, Cupps discloses an information management and synchronous
communications system, wherein the second menu is created in conformity with hypertext markup
language or extensible markup language (see col. 10, lines 8-56 and figures 7-10).

As claims 12-19 and 31-39 are analyzed as previously discussed with respect to claims 1-

11 above.
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Application/Control Number: 09/400,413 Page 4

Art Unit: 2173

Allowable Subject Matter
3. Claims 20-30 and 40-43 are allowed over the prior art of record.

Applicant has claimed uniquely distinct features in the instant invention which are not
found in the prior art either singularly or in combination. They are an information management
and synchronous communications system for generating and transmitting menus a sub-modifier
menu stored on data storage device and displayable in a window of graphical user interface, and
application software for generating a second menu from first menu and transmitting second menu
to a wireless handheld computing device or Web page. These features are not found or suggested
in the prior art.

The present invention is directed to an information management and synchronous

communications system for generating and transmitting menus. Each independent claims 20 and

40 are identified the uniquely distinct features “a sub-modifier menu stored on data storage

generaling a second menu from first menu and transmitting second menu to a wireless handheld

computing device or Web page”. The closest prior art, Cupps (US Patent No. 5,991,739) and

Chen (US Patent No 5,724,069) discloses convention of user interactive interface providing an
on-line ordering distribution, either singularly or in combination, fail to anticipate or render the

above underlined limitations obvious.
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Application/Control Number: 09/400,413 Page 5

Art Unit: 2173

Conclusion
4. The prior art made of record and not relied upon is considered pertinent to applicant's

disclosure and provided on the attached Form 892.

Response
5. Responses to this action should be mailed to: Commissioner of Patents and Trademarks,
Washington, D.C. 20231. If applicant desires to fax a response, (703) 308-6306 may be used for
formal communications.

Please label “PROPOSED” or “DRAFT” for informal facsimile communications. For after
final responses, please label “AFTER FINAL” or “EXPEDITED PROCEDURE” on the
document.

Hand-delivered responses should be brought to Crystal Park II, 2121 Crystal Drive,
Arlington, VA, Sixth Floor (Receptionist).

Inquires

6 Any inquiry concerning this communication or earlier communications from the examiner

should be directed to Cao (Kevin) Nguyen whose telephone number is (703) 305-3972 The

examiner can normally be reached on Monday-Friday from 8:30 am to 6 .00 pm.
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Art Unit: 2173

If attempts to reach the examiner by telephone are unsuccessful, the examiner’s
supervisor, John W. Cabeca, can be reached on (703) 308-3116 The fax number for this group is
(703) 308-6360.

Any inquiry of a general nature or relating to the status of this application or proceeding

should be directed to the Group receptionist whose telephone number is (703) 305-3900.

PATENT EXAMINER

Qe

Cao “Kevin” Nguyen
November 27, 2000
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through the keyboard port. The input elements of the,ustr
interface thus make use of the standard keyboard drifers
pormally available in a gencral purposc microcomputer to
communicate with the application program. The application
program in the computer memory displays on-the-sarecn
sclection indicators for available options coordinated to the
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to select an option. The application program may present ta
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5.724.069

1

SPECIAL PURPOSE TERMINAL FOR
INTERACTIVE USER INTERFACE

FIELD OF THE INVENTION

The present inveation relates generally to a
mictocomputer-based terminal, and more particularly to a
special purposc terminal based om a gemcral purposc
microcomprricr, and having a simplified user interface.

BACKGROUND OF THE INVENTION

Special purpose microcomputer-based terminals have
been widely used in comsumer service applications. For
example, a department store can usc an imteractive terminal
to provide a customer with information about the prices and
selections of goods in the store. or a restaurant can use an
intecactive terminal for taking orders from a customer.
Generally the terminal-user interactive interface is accom-
plished by the terminal presenting available options on an
output device to a user, and the user indicating through an
input device the option sclected. Many differcot types of
input and outpt devices may be used For example. the
output device may be a priater or & display screen. and the
input device may be a standard keyboard or a mouse. A
touch screen may also be used to serve both the input aad
outpik (1/0) functions.

Using a standard keyboard in the user interface is quite
acceptable for a general purpose terminal. where some
computer familiarity is expected. but for a special purpose
terminal for the non-computer experienced user, the stan-
dard keyboard imtarfacc is less than desirabke. It may present
too many options. it may trigger a computer-phobic reaction.
and indeed it may present too many oppartunities for a user
to affect the computer terminal beyond the intended limited
special purpose functions inteaded

Heretofore. a particularly attractive user interface for
special purpose terminals has boen the touch screca. When
a touch screen is used as the /O device of an interface
terminal. the application program can be designed to display
selection indicators on the sacca, and a touch of a sclection
indicator on the screen will be detected and interpreted by
the program as the selection of that option. A touch sareen
is often preferred to a keyboard or a mouse as the input
device because the uscr actions for using a touch sacen, e
looking and pointing. are often considered to be simple and
intuitive. It is also oftco desirable to have one device serving
both input and output functions instead of using physically
separate input and output devices.

A touch screen. however, is not without disadvantages.
Special construction and electronics are required for sensing
a touch and determining the location of the touch on the
screen. Feeding such information into the microcomputer
also requires specially desigaed driver circuits and a spe-
cially designed computer interface. These special circuits
not only increase the cost of the touch screen interface. but
also increase the difficulty of software development becausce
the software must be specially designed to communicate
with the driver circuit. The system portability of the inter-
face terminal is also reduced because the touch screea
cannot be used with another microcomputer which does not
have the special drivers. The special design of the front ead
(interface and drivers), typically demands that a special
purpose terminal with touch sareen interface be available for
developmeat or modification of application programs.

Another problem with the touch screen is that the sareen
can get contaminated from contact with hands rather
quickly. This problem is especially serious in a restaurant
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2
setting where the device is used for menu selection, because
the user of the terminal may also have to handle foods.
Devices using a keyboard or a mouse arc also not suitable
for restaurant applications due to the danger of accidental
damage caused by. for example, spilling driak dnthe key-
board.

SUMMARY OF THE INVENTION

In view of the foregoing. it is a general aim of this
inveation to provide a special purpose terminal using gen-
eral purpose computer hardware. to achieve simplicity and
directness like that of a touch screen. but to avaid the
disadvantages of a touch screen.

In accomplishing that aim. it is an object of the present
invention to provide a special purpose terminal using gen-
eral purpose computer hardware to the maximum extent
possible., and to achicve a user interface like that of a touch
screcn. but without the complication or expensc of special
purpose drivers or interface circuits psormally associated
with a touch screen. K is a related object to use the drivers
sormally associated with a geacral purposc computer to
interface a special purpose user-friendly input device to the
general purpose computer.

Acrording to a particular application of the inventioa, it
is an object to provide a user interface device which is
suitable for usc in an environment like a restaurant where
contamination of the device is a concern.

It is a feature of the inveation that a standard general
purposc¢ microcomputer is operated without a standard
keyboard. and a special purpose user interface is coanected
to the keyboard port of the gencral purpose computer. the

application software of the system serving to assign func-
tions to an array of pushbuttons of the user interface, and to

interpret pushbutton actuatioas according to the assigned
functioas.

It is a subsidiary feanme of the invention that the appli-
cation programs for the special purpose terminals are
designed in several levels, preferably pested in hierarchal
mecau trec fashion, and the fumctions are assigaed by
displaying. on a general purpose display. the functions for
the respective pushbuttoas. with at least some of the func-
tions changing with changing level. The application then
interprets an actuation of a pushbutton according to the level
existing at the time of the actuation.

Thus. it is a resulting feature of the inveation that an array
of conveantional pushbuttons can be interfaced to the general
purpose microcomputer via a keyboard port. the display
driven by the application software to provide touch screen
like functionality to the pushbuttons. with the multiple lcvels
of the application assigning multiple functions to the push-
buttons depending on the level. It is a significant feature that
this is all accomplished without the nced for any special
purpose interface boards in the computer and without the
need for specially design screens capable of sensing touch.

These and other features of the invention are achicved by
providing a special purpose microcomputer-based terminal
for interactive user interface. The terminal utilizes a general
purposc microcomputer having 2 display port and a key-
board port. The keyboard pon is interfaced to a microcom-
puter keyboard driver of the type responsive to interpret
kcystroke signals in a standard format tra itted from a
standard alphanumeric keyboard. However, the
microcomputer-based terminal does not have a standard
alphanumeric keyboard connected to the keyboard port.
Instead. a user input module includes a plurality of cloctlica.l
pushbuttons arranged along af least one side of the display
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and an encoder circuit for detecting the actation of cach
pushbutton and producing a keystroke signal ideatifying the
actuated pushbutton and compatible with the standard for-
mat of the keyboard driver. The user input module is
conpected to the microcomputer via the keyboard port. A
standard geaeral purpose display screen is connected to the
display port of the microcomputar. A program memory in the
microcomputer contains instructions which (a) assign spe-
cific input functions to the pushbuttons. and (b) display
pushbutton function assignments on the display screea in
positions coordinated to the positions of the pushbuttons.
The program memory also contains instructions which
respoad to signals received from the keyboard driver initi-
ated by actuation of a pushbutton by determining the func-
tion specified by the pushbutton actuation and executing the
determined function.

In a more particular embodimeat, a program memory in
the microcomputer contain an input/output module having
multiple levels for assigning level-specific functioas to the
pushbuttons. The input/output module includes a display
module for displaying on-the-sareen representations of the
pushbuttons and the functions assigncd to the pushbuttons at
each level. The input/output module also includes an inter-
peeter for interpreting a keystroke signal in acoordance with
the function assigned to the actuated pushbutton at the
associated level The memory, in addition to the
input/output module. also contains as application module
for executing the interpreted function assigned to the push-
button at the interpreted level.

In a particular application. the special purpose termigal is
a wailer’s terminal for a restaurant in which the multiple
levels of the input/output module include a stored series of
pested menus including root level menus branching to
elemental level menus. The root level menu is adapted to
assign the courses of a meal to the function krys. a mid-level
menu is adapted to assign selections to the courses specified
in the root level menu. and sub-level menus are adapted to
refine the sclections in the mid-level menus. The application
module is adapted to guide the user through the menus in
completiag a selection of a meal. and to produce. at a
printout station. an itemized check

Other objects and advantages will become appareat from
the following detailed description when taken in conjunction
with the drawings. in which:

BRIEF DESCRIPTION OF THE DRAWINGS

FIG. 1illustrates a presently preferred embodiment of the
interface terminal of the present invention;

FIG. 2 shows an embodiment of the interface module
acocording to the present invention and graphic representa-
tions of the pushbuttons displayed on the screen of the
interface module;

FIG. 3 shows a schematic illustration of the functional
arganization of the tearminal of the present invention;

FIGS. 4A-4F illustrate a sequence of screen displays for
a restaurant application which presents meau selections
arganized in 2 hierarchal meau tree fashion;

FIG. § shows a flow chart illustrating the sequence of
operation of an application program haviag multiple levels
of functions; and

FIG. 6 shows a flow chart illustrating the process of
eatering alphanumeric information into a terminal of the
present invention.

DETAILED DESCRIPTION OF THE
PREFERRED EMBODIMENTS
While the inveation will be described in connection with
certain prefemred embodiments. there is oo iatention to Limit
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it to those embodiments. On the contrary, the intent is to
cover all alternatives. modifications. and equivalents
included within the spirit and scope of the invention as
defined by the appended claims.

Turniog now to the drawings. FIG. 1 shows an embodi-
meat of the interactive interface terminal 108 of the present
invention, which comprises an iaterface module 20 and a
microcomputer 18. The microcomputer 18 is a gencral
purpose compiter comprising a microprocessar-based CPU.
The phrase “gencral purpose™ as used hercin means that the
microcomputer is of the type gencrally available for inter-
faciag with a variety of devices and capable of operating a
wide range of software applications. It is to bc contrasted
with “special purpose”™. which connotes a microcomputer
system specially adapted for a limited specific purpose. An
example of the former is the wide range of DOS-based
computers available from a large number of manufacturers.
while an exampie of the lanter might be a terminal dedicared
to dispessing lottery tickets.

The general purpose microcomputer 1@ coaventionally
has a keyboard port 12 and a display port 14. A standard
alphanumerical keyboard is typically connected to the
microcomputer through the keyboard port. ofien to serve as
the primary input device. The general purpose computer
used in the terminal of the present inveotion. however. does
oot have a standard keyboard conaected to the keyboard port
12. The display port 14 aliows a standard display screcn 38
to be connected to and driven by the microcomputer. The
display 3 is illustrated as a CRT. although other forms such
as the LCD display can be used.

Internally to the microcomputer 10. the keyboard port 12
is interfaced to a keyboard driver 16 (FIG. 3). The keyboard
driver is compatible with a standard aliphanumerical
keyboard. asd includes hardware and software clements.
The hardwarc clements include the necessary integrated
circuits and the like which accept signals from the keyboard
and process them to produce data words recognizable by the
microcomputer system. The software elemeats include key-
board driver clements. typically resident within the input/
output system (e_g.. the BIOS). which process the keyhoard
signal to produce data words which serve as inputs to the
microprocessof within the computer system. Both the hard-
ware and software clements are resident in the typical
general purpose microcomputer 19 such that it is oaly
necessary to plug a keyboard into the port 12, the hardware
and software clements of the keyboard driver being avail-
able to immediatety accept input from the keyboard

Geoerally. a keyboard functions by converting a key-
stroke into an electrical signal. generally a binary code. To
that end. the conventional keyboard itself usually includes a
keyboard encoder which performs the ordinary tasks of
scanning the keyboard. detecting actuations of any keys. and
producing binary coded signals indicating the identity of the
key which had been depressed. The code which is produced
by the eacoder is transmitted to the micocomputer through
a signal bus terminated with a connector 21 coanected to the
keyboard port 12. The keyboard driver 16 (FIG. 3) within
the microcomputer receives the code and produces data
words accessible to the microcomputer system for determin-
ing which key has becn actuated. and responding according
to the program in operation at the time. Because a keyboard
is a standard input decvice for gemeral purpose
microcomputers. most general purpose microcoraputers
contain a keyboard driver as a standard feature.

In accordance with am important aspect of the present
invention. the special purpose interface module 20 rmakes
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full use of the keyboard port 12 and its associated drivers in
integrating the special purpose user interface of the present
inveation with a general purpose microcomputer 10. In
addition. the interface module 2¢ of the present invention
makes usc of a gencral purpose display screen 34, such as
the illustrated CRT. driven from the standard display port 14
through a coanection cable 34. It will thus be appreciated
that the only truly special purpose features of the present
invention arc the input intcrface clements themsclves. the
remainder being elements which are integral to the readily
available, and generally inexpensive available. standard
microcomputer system.

Turning in greater detail to the input aspects of the
inveation, the input module 25 (FIG. 3) comprises a plural-
ity of pushbuttons 40 mounted on a bezel 41 swrounding the
screen 3. Preferably. the pushbuttons 40 are aranged in
lines along two or more sides of the display screen 38. The
interface module 28 in FIG. 1 has cight buttons above the
screen 34 and cight buttons along the right side of the screen.
forming an inverted “L" shaped array. The sumber of the
pushbuttons and their locations alongside the screen can be
varied accordiag to the nceds of a specific application. For
instance. the pushbuttons can be located along only one side
of the screen 38. It is prefared. bowever, to amange the
pushbuttons 48 in an inverted L-shape forming two lines,
one along the top and the other along the right-hand side of
the screen 3. In conjunction with the display which is
utilized in the assignment of functions to the pushbuttons,
the invested L as illustrated in the figures is most readily
suited for case of operation by 2 right-handed person. In
order to produce signals which are readily interpreted by the
keyboard driver of the standard microcomputer, the input
module includes an encoder circuit 24 (FIG. 3) which senses
the actuation of the pushbuttons and gencrate keystroke
signals which are identical in form to the keystroke signals
generated by a standard keyboard. The keystroke signals arc
transmitted through a signal bus 22 terminated with a

ctor 21 cted to the keyboard port 12. Because the
keystroke signals are compatible with the standard format of
the keyboard driver, they can be handled by the keyboard
driver. and processed by the BIOS to be made availabie to
the application software being operated in the microcom-
puter. As a result, no specially designed drivers (cither
hardware or software) are needed for handiing the input
from the interface module.

There are significant advantages to using an interfacc
module which can be driven by a general purpose micro-
computer without any specially designed drivers. The cost of
the terminal system is lower and installation of the system is
simpler because no special drivers are required. The inter-
face module is slso more portable in the sense that it can be
matched with different microcomputers without haviag to
install special drivers. Because the method of interfacing a
keyboard to a general purpose microcomputers is fairly
standardized. developing an application program which
receives input from the keyboard port generally requires less
testing and debugging than developing a program receiving
input from a specially designed driver circuit. Furthermare,
new applications can be developed or existing applications
can be modified without the nced for a special purpose
terminal. Indeed, software development cam be performed
on a standard microcomputer using a standard keyboard, so
long as the software developer knows the particular codes of
the keyboard signals which will be used for each of the
buttons 40 in the special purpose terminal 109,

In practicing the invention. there is provided. in combi-
nation with the array of pushbuttons around the display.
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means for assigning particular functions to the pushbuttons.
and changing the assignment of functions at different levels
of the application program. Becausc thc number of push-
buttons should be quite limited in order to keep the user
interface reasonably simple and intuitive, it will usually be
desirable to assign maltiple functions to at lcast some of the
pushbuttons. It is therefore necessary to indicate to a user
which function has been assigred to a pushbutton.

FIG. 2 illustrates a peeferred means for accomplishing
that. The interface module 20 as shown in FIG. 2 has an
array of pushbuttons 48 which are individually numbered
101-116. As shown in FIG. 2. thc application softwarc
opezated within the microprocessor causes the display on the
screen 38 of a group of graphic represcatations 46 individu-
ally numbered 202-207, 209-215. A graphic representation
is a graphic image suggestive of a pushbutton. The graphic
represeatations 46 arc positiogally juxtaposed to the push-
buttons 40. and indicating the function which is curreaty
assigned to cach of the pushbuttoas. To further assist the user
in selecting a function. information about the functions may
also be displayed on the screen. By coordinating represen-
tations 46 on the screen M to the positions of the pushbut-
tons 40 along the sides of the screca. the user can clearly tell
which pushbutton 44 is assigned to which graphic represen-
tation.

FIG. 2 shows the prefemred embodiment of the interface
module of the present invention which has the pushbuttons
48 arranged in an inverted “L” shape. Because the repre-
sentations 46 of the pushbutions are positionally coordinated
to the pushbuttons 48, the center of the screen 30 is free for
display of application information.

When the user actuates a pushbutton 48, a keystroke
signal is seot %o the keyboard deiver 16 (FIG. 3). The
mogram uscs the signal reccved through the keyboard
driver to determine which pushbutton has beca actuated.
thereby determining which function has been selected. For
examplec, whea the pushbutton 202 is actuated. the function
assigaed to it by the program is selected.

Besides being used to sclect functions. the pushbuttons
can be uscd for entering alphanumeric data. For example,
the function assigned to pushbution 242 in FIG. 2 may be (o
input the digit “1”. Pressing that button then interpreted by -
the program as that the digit “1"has been cntered.

It mxy be desirable in some situations to assign permanent
functions to some of the pushbuttons, and those functions
can cither be assigned. insofar as the usear interface is
concerned. by indicators on the screen 3. or by permanent
markings on the buttons 40. In the preferred embodiment of
the interface modulc as shown in FIG. 2. the three pushbut-
tons 101. 108, 116 located at the upper left. upper right, and
lower right corners of the bezel 41 surrounding the screen 49
arc gencrally resarved for those fixed special functions.

FIG. 3 illustrates schematically the functiopal organiza-
tion of the terminal of the present invention. The application
program 5¢ in the memory can gemcrally be viewed as
functionally comprising two major modules. The first mod-
ule is the IX0 module 60 which is responsible for controlling
the course of the computer-user intcraction. The course of
interaction may be viewed as comprising many levels. and
at each level the user is required to make one choice. The
operation of the program comrespondingly has maay levels.
At each level the VO moduke 68 paforms the output
function of presenting to the user a sat of functions for the
user to choose from. and the input function of recciving a
keystroke signal from the user indicating which function has
been selected The functions preseated to the user are
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level-specific. meaning that which functions arc presented
depeads oo the level of operation. The /O module 68 also
assigns the level spedific functions to the pushbuttons 48 so
that the uscr can press onc button to select its assigned
function.

The sccond module in the application program is the
application module 66. This module is respoasible for
camrying out the functions sclected by the user. For instance,
a selected function can be printiog out a check 282 on an
attached printer 200, or displaying a road map on the display
screen .

Based on the input or output functions, The /O module 64
can be further viewed as comprising a display module 62
and an interpreter 64. The display module 62 performs the
output function of displayisg on the screen graphic repre-
scntations 46 of pushbuitons aad their respectively assigned
level-specific functions. The inlerpreter 64 performs the
input function. The interpreter 64 receives from the key-
board driver 16 a signal identifying the pushbutton 44 that
has been pressed. and checks the level-specific function
assignments of the pushbuttons 4 to determine which
function has been selected by the user. It will be appreciated
that cach level of interaction involves the oparation of the
display module 62 and the interpreter 64.

Operating the tarminal of the present invention requires
simply looking at the sctecn 30 and pressing a buton 44.
Due to the visual conpection between the buttons and the
graphic representations 46, these actions are relatively
sirnple and intuitive, and are very similar to the looking and
pointing actions for a touch screen.

While providing case of operation similar to that of touch
screens. the interface module of the preset iaveation has
several advantages over a touch screen. First. unlike touch
screens which requires special construction and electronic
circuits for detecting a touch. dectrical pushbuttons arc
simple devices which are inexpensive and easy to maintain.
Second. the present invention utilizes the already existing
drivers in the microcomputer, thereby climinating the need
of a specially designed drivers or interfaces.

In many applications. the instructions in the application
memory of the microcomputer can be programmed to
present to a user functions organized in a hierarchical menu
tree fashion. At a gives time the program displays on the
screen selectior indicators for options on ooe level of the
menu tree. After the user sclects an option by pressing a
button. the program responds by presenting new functions
on the next level of the meau tree to the usec. Which new
options are presented depends on which option has been
selected. By coasecutive actuations of the buttons. a user can
select a path through the meou tree.

Inputting and processing orders from a customer in a
restaurant. that is functioniag as a special purpose waiter’s
terminal. represents a cumrently preferred application for a
microcomputer-based terminal according to the present
invention. The terminal of the present invention is well
suited for such an application, because its interface module
is less scasitive to contamination than a touch screen. and is
not as susceptible to accidental damage as a standard key-
board. Its simplicity of operation also makes it superior to a
interface terminal using a keyboard or 2 mouse.

When a terminal of the presest invention is used as a
waiter's terminal for entering orders from customers. the
multiple levels of input/output module may include a stored
scries of nested menus containing options available from a
regular restaurant menu. The menus are nested to provide a
basic or root level menu branching to elemental level menus.
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the clemental memus including. at least in some cases.
mid-fevel menus followed by sub-level menus. This nesting
is convenient in order to automatically move from a sclec-
tion at a root level to the options available at a mid-kevel to
refinements to the selected options available at sub-level
menu. The user need not be concerned with how to get from
kevel to lkevel in order to make the selections. Simply making
a selection at one of the higher level menus indexes the level
to the next sequential appropriate level. based on the selec-
tion already made. so that the sub-items and refinements can
be selected.

In greater detail, FIGS. 4A-4F illustrate a scries of
screens forming at least ome branch of a series of nested
meaus im a waiter’s tomisal according to the prescmt
invention. These figures each show a display screen 30
illustrated at one level of the application software. They also
illustrate the multi-function pushbuttons 48 amranged on the
bezel 41 surounding the screen 34. and demonstrate a
sequence of steps for selecting a path through the hicrarchal
meau tree of options.

Beginning with FIG. 4A. the screen 30 shows graphic
represeatations 46 in rectangular boxes for optioas on the
root level of the menu tree. indicating that the user can order
dinner. lunch. appetizer, refreshments or drink. The graphic
representatioa labeled DINNER in FIG. 4A is shaded to
indicate that it is sclected by the user. The same convention
is used in FIGS. 4B-4F. The representations labeled
DELETE LAST and REPEAT LAST allow the user to
chanoge the last selected itcm. or to duplicate it. Moving now
to FIG. 4B. after the user selects the dinner option, the screen
shows different types of entree, and steak is selected. FIGS.
4C & 4D show screen displays allowing the user to sclect the
type of stcak and how it is cooked. FIG. 4E shows that the
user can choose between salad and French fries (FF). and the
user chooses salad. After choosing salad the order for dinner
is complete. and the screen display in FIG. 4F shows again
represcntations 46 for the options on the root level. The
waiter can then enter other selections such as a drink order
or amother dinner or, alternatively. can actuate the cater
pushbutton which enters the order for processing. Displays
in the kitchen and other related aspects of the system are not
directly related to the present invention and therefore will
not be described. Ry

While the 'O modulc 68 (FIG. 3) of the program for the
waiter’s terminal handles menu selection, the application
module of the program is preferably configured to help
guide the user through the meous in completing a selection
for a meal. For example, the application program can display
on the screen the descriptions of items ordered, their indi-
vidual and total costs. etc. After the selection for a meal is
completed, as illustrated in FIG. 4F. the application module
may produce. as illustrated in FIG. 3. a detailed check 262
on a printout station 240 showing the selections. their
individual costs and the total cost, etc.

An application program for a waiter's terminal can. of
course, have many more levels than the levels illustrated in
FIG. 4A—4F. The menu tree formed by the levels shown in
FIG. 4A-4B which is can be only a branch of a much larger
menu tree structure. with levels above and below it. For
instance, before entesing the order entry sequence shown in
FIG. 4A-4F the program may requirc the user to indicate
whether he is taking 2 new order or adding 2 new item to an
existing order.

FIG. § presents a flow chart illustrating the scquence of
operation when usiag an application program which config-
ures the terminal system as a waiter's terminal. The program
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